Autodesk® 3ds Max® 2011

Autodesk® 3ds Max® Design 2011

Installation
## Contents

Chapter 1  **Stand-Alone Installation**  ........................................ 1

- Differences Between 3ds Max and 3ds Max Design  ...................... 1
- Preparing for Installation  .................................................. 2
  - Recommended Minimum System Requirements  .......................... 2
    - DVD or Electronic Download  ........................................ 2
    - Supported Operating Systems  ....................................... 2
    - Software Requirements  ............................................... 3
    - Hardware Requirements  ............................................. 4
    - 32-bit and 64-bit Combinations  .................................... 6
    - Calculating the Appropriate Swap File Setting  .................... 7
  - Administrative Permission Requirements  ................................ 8
  - Mac Requirements  ................................................................ 8
    - Boot Camp  ..................................................................... 8
    - Mac Virtualization on Parallels Desktop  ............................. 8
  - Locating Your Serial Number and Product Key  .......................... 9
  - Minimize the Chances of Installation Failure  .......................... 10
- Documentation and Support  .................................................. 10
  - Install Documentation Set  .............................................. 11
  - Help and Tutorial Documentation Set  ................................ 11
- Installing and Running the Product  ......................................... 12
  - Installing 3ds Max/3ds Max Design  .................................... 12
  - Interrupting the Install Process  ........................................ 18
  - Registering and Activating Your Product  ............................... 18
  - Obtain an Activation Code Online  ...................................... 18
Chapter 4 Troubleshooting .................................................. 61
General Installation Issues .................................................. 61
   How can I check my graphics card driver to see if it needs to be updated? ..................... 61
   What should I do if I run into graphics card issues during startup? ............................... 63
   What is the benefit of using a network licensed version of the software? ....................... 63
   How do I access my product documentation? ............................................................... 63
   What is SAMreport-lite? ............................................................ 64
Deployment Issues .............................................................. 64
   Where can I find the Deployment Checklist? ................................................................. 64
   Where can I check if service packs are available for my software? ............................... 64
   How do I extract an MSP file? .......................................................................................... 64
   Where can I learn about InfoCenter, including search locations? .................................. 65
   What are information channels? ...................................................................................... 65
   What are RSS feeds and how do they benefit my installation? ......................................... 65
Networking Issues ................................................................. 65
   Where do I find my server name? ...................................................................................... 66
   What is an administrative image (MSI) file? .................................................................... 66
   What is the impact of selecting all products for the administrative image, and can I add products later? ................................................................. 66
Uninstall and Maintenance Issues ............................................ 66
   Is it possible to change the installation folder when adding or removing features? ........... 66
   When should I reinstall the product instead of a repair? .................................................. 67
   Do I need my original disc(s) to reinstall my product? .................................................... 67
When I uninstall my software, what files are left on my system? ........................................ 67

Glossary ......................................................... 69

Index ............................................................. 71
Stand-Alone Installation

The Autodesk 3ds Max 2011 / 3ds Max Design 2011 Installation Guide provides instructions about how to prepare and then install Autodesk 3ds Max 2011 or Autodesk 3ds Max Design 2011. If you have never installed the product before, you should familiarize yourself with the entire installation process and options before you begin.

For information on deploying 3ds Max or 3ds Max Design, see Network Administration and Deployment on page 43.

For information about licensing a stand-alone or network deployment, refer to the Licensing Guide. (Click Documentation in the lower-left corner of the installer.)

Differences Between 3ds Max and 3ds Max Design

Though this guide is shared between 3ds Max and 3ds Max Design, there are some key differences between these two products—as 3ds Max Design is intended for architecture and visualization customers, the tutorials and movies that are included show typical applications and scenarios for these customers. In addition, 3ds Max Design contains Exposure™ lighting analysis technology, which is designed specifically for architecture and visualization work flows. To learn more about Exposure lighting analysis, refer to the 3ds Max Design Help.

The tutorials and movies included with 3ds Max demonstrate 3D pipelines typically employed by artists and animators in films, games and television-related fields. In addition, 3ds Max ships with the SDK which can be used to add your own plug-ins to your 3ds Max pipeline. The only difference that you will notice during the install procedure is that you cannot install the SDK with 3ds Max Design.

It is possible to install both 3ds Max and 3ds Max Design on the same machine—a unique serial number and product key for each product is required to activate the software so that you can run the products beyond the 30-day trial period.
Preparing for Installation

To prepare for installation, you should review the system requirements, understand administrative permission requirements, locate your 3ds Max/3ds Max Design serial number and product key, and close all running applications. Complete these tasks, and you are ready to begin installing 3ds Max/3ds Max Design.

Recommended Minimum System Requirements

Before you begin the install process, make sure your system meets the minimum software and hardware operating requirements for Autodesk 3ds Max 2011 or Autodesk 3ds Max Design 2011. The following sections outline the system requirements at release time. Mac users, see Mac Requirements on page 8.

For the latest system requirements, see:

■ www.autodesk.com/3dsmax-sysrequirements
■ www.autodesk.com/3dsmaxdesign-sysrequirements

For the latest hardware qualification information, see:

■ http://www.autodesk.com/max-hardware

DVD or Electronic Download

Autodesk 3ds Max/3ds Max Design 2011 is available only on dual-layer DVD media (or electronic download in some situations). CD media is no longer available. A DVD-ROM drive is not required if you are installing using an electronic download. However, to accommodate the installation files, you will need 9 GB of hard disk space and an additional 16 GB of space for temporary files created during the installation.

Supported Operating Systems

The 32-bit version of Autodesk 3ds Max 2011/Autodesk 3ds Max Design 2011 software is supported by any of the operating systems:

■ Microsoft® Windows® XP Professional (SP2 or higher)
■ Microsoft® Windows Vista® Business (SP2 or higher)
■ Microsoft ® Windows ® 7 Professional

The 64-bit version of 3ds Max 2011/3ds Max Design 2011 software is supported by any of the operating systems:
■ Microsoft® Windows® XP Professional (SP2 or higher) x64
■ Microsoft® Windows Vista® Business (SP2 or higher) x64
■ Microsoft ® Windows ® 7 Professional x64

The Autodesk 3ds Max Composite feature requires one of the following 32-bit or 64-bit operating systems:
■ Microsoft® Windows® XP Professional (SP2 or higher)
■ Microsoft® Windows ® XP Professional x64 (SP2 or higher)
■ Microsoft ® Windows ® 7 Professional x64

Software Requirements

3ds Max 2011 32-bit and 64-bit software requires the following supplemental software:
■ Microsoft ® Internet Explorer ® 7.0 Internet browser or higher
■ Mozilla Firefox® 2.0 Web browser or higher
■ You will need Acrobat® Reader® to view all of the PDF documents on your Software DVD. If you do not have Acrobat Reader installed, you can go to the Adobe Web Site at http://www.adobe.com/products/acrobat/readstep2.html
■ Adobe® Flash Player is required to view the Hot Key Map (available from the Help menu) and view the Essential Skills Movies. If you do not have Adobe® Flash Player installed, you can go to the Adobe Web Site at http://www.adobe.com/products/flashplayer/
Hardware Requirements

The following four sections describe the hardware requirements depending on whether you are using 32- or 64-bit 3ds Max/3ds Max Design and on the complexity of your scene.

General Animation and Rendering—32-bit

Use these hardware requirements when working with typically fewer than 1,000 objects or 100,000 polygons and with the 32-bit version of 3ds Max/3ds Max Design 2011 software.

- Intel® Pentium® 4 1.4 GHz or equivalent AMD® processor with SSE2 technology
- 2 GB RAM (4 GB recommended)
- 2 GB swap space (4 GB recommended)
- Direct3D 10, Direct3D 9, or OpenGL-capable graphics card
  - 256 MB or higher video card memory
  - 1 GB or higher recommended (especially when using the Quicksilver Hardware Renderer)
- Three-button mouse with mouse driver software
- 3 GB free hard-drive space
- DVD-ROM drive
- Internet connection for Web downloads and Subscription-aware access
- 3ds Max Composite media cache hard-drive requirements:
  - 10 GB minimum, 200 GB recommended
  - HDD: IDE, SATA, SATA 2, SAS, SCSI
General Animation and Rendering—64-bit

Use these hardware requirements when working with typically fewer than 1,000 objects or 100,000 polygons and with the 64-bit version of 3ds Max/3ds Max Design 2011 software.

- Intel® 64 or AMD64 processor with SSE2 technology
- 4 GB RAM (8 GB recommended)
- 4 GB swap space (8 GB recommended)
- Direct3D 10, Direct3D 9, or OpenGL-capable graphics card:
  - 256 MB or higher video card memory
  - 1 GB or higher recommended (especially when using the Quicksilver Hardware Renderer)
- Three-button mouse with mouse driver software
- 3 GB free hard-drive space
- DVD-ROM drive
- Internet connection for Web downloads and Subscription-aware access
- 3ds Max Composite media cache hard-drive requirements:
  - 10 GB minimum, 200 GB recommended
  - HDD: IDE, SATA, SATA 2, SAS, SCSI

Large Scenes and Complex Data Sets—64-bit

Use these hardware requirements when working with typically more than 1,000 objects or 100,000 polygons. In these cases the 64-bit version of 3ds Max/3ds Max Design is required.

- Intel® 64 or AMD64 processor with SSE2 technology
- 8 GB RAM
- 8 GB swap space
Direct3D 10, Direct3D 9, or OpenGL-capable graphics card

■ 1 GB or higher video card memory

■ Three-button mouse with mouse driver software

■ 3 GB free hard-drive space

■ DVD-ROM drive

■ Internet connection for Web downloads and Subscription-aware access

■ 3ds Max Composite media cache hard-drive requirements:
  ■ 10 GB minimum, 200 GB recommended
  ■ HDD: IDE, SATA, SATA 2, SAS, SCSI

The following specifications provide further details about certain hardware requirements:

■ Autodesk 3ds Max/3ds Max Design 2011 has been optimized to take advantage of the SSE2 extended instruction sets supported on Intel® Pentium® 4 or higher, AMD Athlon™ 64, AMD Opteron™ AMD Phenom™ processors. 3ds Max/3ds Max Design 2011 will not operate on computers that do not support SSE2. Several utilities are available on the Internet that report CPUID, including supported instructions sets.

■ Autodesk recommends settings that allow Microsoft Windows to manage virtual memory, as needed. There should always be at least twice as much free hard disk space as system memory (RAM).

■ Some features of 3ds Max 2011 are enabled only when used with graphics hardware that supports Shader Model 3.0 (Pixel Shader and Vertex Shader 3.0). Check with your manufacturer to determine if your hardware supports Shader Model 3.0.

32-bit and 64-bit Combinations

When you install 3ds Max or 3ds Max Design, the installer detects whether your machine is 32- or 64-bit. On a 64-bit machine with a 64-bit operating system, you have the option of installing either the 32- or 64-bit version (as well as installing both of them on the same machine, and running them both
Calculating the Appropriate Swap File Setting

A good rule to keep in mind for configuring the size of your Windows swap file (paging file) is to have three times the amount of physical memory (RAM) on your system. Depending on scene complexity, more swap space might be desirable. When you output to high-resolution film or print work, the demands will be much higher than for video resolutions. This is especially true when using Image Motion Blur.

Many users dedicate entire hard-drives or partitions as swap files. Setting swap files in this manner avoids any fragmentation of the swap file.

It is very important that you have sufficient swap space set aside. A common cause of system instability is an improperly sized swap file.
Administrative Permission Requirements

To install 3ds Max/3ds Max Design, you must have administrator permissions. You do not need to have domain administrative permissions. See your system administrator for information about administrative permissions.

You do not need administrator permissions to run 3ds Max/3ds Max Design. You can run the program as a limited user.

Mac Requirements

The two options for using 3ds Max/3ds Max Design 2011 on Mac® are to use Boot Camp® or to use the Mac via Parallels Desktop for Mac.

Boot Camp

You can install 3ds Max 2011 / 3ds Max Design 2011 software on a Mac computer on a Windows partition. The system must use Boot Camp to manage a dual OS configuration and meet these minimum system requirements:

- Intel-based Mac Pro or MacBook Pro

  **NOTE** 64-bit Windows Vista requires an Intel Core® 2 duo or Xeon® processor.

- Apple® OS X 10.5.x or higher
- Boot Camp V 2.0 or higher
- Minimum 2 GB RAM (Recommend 4 GB for 32-bit Windows OS, 8 GB or more for 64-bit Windows OS)
- Minimum 20 GB disk space for Apple OS partition, minimum 20 GB for Windows OS partition

Mac Virtualization on Parallels Desktop

Autodesk 3ds Max 2011/Autodesk 3ds Max Design 2011 can be used on the Mac via Parallels Desktop for Mac without having to boot directly into the
Windows OS so you can switch between platforms. The system must meet the following requirements:

- Intel-based Mac Pro or MacBook Pro
- Mac OS X 10.5.x or higher
- Parallels Desktop 4.0 (4.0.3844 or higher)

**NOTE** Parallels Desktop is the only supported virtual machine software at this time.

- Minimum 4 GB RAM (6 GB system memory for 32-bit Windows OS, 8 GB or more for 64-bit Windows OS recommended)
- Minimum 40 GB available disk space (100 GB recommended)

**Locating Your Serial Number and Product Key**

When you install 3ds Max/3ds Max Design, you are prompted for your serial number and product key in the Product and User Information page, or the option of installing the product in trial mode. You may enter your product information at any time during your trial mode period if you opt to install the product in that mode.

The serial number and product key are located on the outside of the product packaging, or in the Autodesk® Upgrade and Licensing Information email. Make sure to have these available before you install the program so that you don't have to stop in the middle of the installation.

The serial number must contain a three-digit prefix followed by an eight-digit number. The product key consists of five characters.
The information you enter is permanently retained with the product. Because you can’t change this information later without uninstalling, take care when entering the information. To review this product information later, on the InfoCenter toolbar, click the drop-down arrow next to the Help button (the question mark). Then click About - Product Information.

**NOTE** If you have lost your serial number or product key, contact the Autodesk Business Center (ABC) at 800-538-6401 for assistance.

### Minimize the Chances of Installation Failure

The installation process might stop if some applications (such as Microsoft® Outlook® or virus-checking programs) are running. Close all running applications to avoid possible data loss.

Additionally, ensure that none of the following programs is running: Autodesk® 3ds Max®, Autodesk® 3ds Max® Design, AutoCAD®, Autodesk® Combustion®, or Autodesk® VIZ.

### Documentation and Support

Documentation and Support links are located in the bottom-left corner of the installer. This Documentation link provides links to the install documentation, including the *Readme*. You can also access these documents by clicking Read The Documentation on the main menu of the Installer. You also have access to these documents on the Software DVD in the `\en-US\Docs` folder.
NOTE The install documentation set is not installed with your product.

The Support link takes you to the support content on Autodesk.com.

### Install Documentation Set

The following table summarizes the install documentation set for Autodesk 3ds Max 2011 and Autodesk 3ds Max Design 2011:

<table>
<thead>
<tr>
<th>Name of Document</th>
<th>File Name</th>
<th>For Information About</th>
</tr>
</thead>
<tbody>
<tr>
<td>Autodesk 3ds Max 2011 or Autodesk 3ds Max Design 2011 Readme</td>
<td>3ds_Max_readme.htm</td>
<td>Late-breaking information related to this version of Autodesk 3ds Max 2011 or Autodesk 3ds Max Design 2011.</td>
</tr>
<tr>
<td>SAMReport-lite™ User’s Guide</td>
<td>Samlite_ug.pdf</td>
<td>SAMReport-lite, which is a reporting tool that helps you track network license usage.</td>
</tr>
</tbody>
</table>

### Help and Tutorial Documentation Set

The Help is accessible on the Help menu of 3ds Max/3ds Max Design. It is also available from the Start menu. (Start ➤ Programs ➤ Autodesk ➤ Autodesk 3ds Max [Design] 2011 [32- or 64-bit] ➤ Help.

The Tutorials link in the Help menu takes you to the HTML tutorials on the Web at www.autodesk.com/3dsmax-tutorials-v2011 and
www.autodesk.com/3dsmaxdesign-tutorials-v2011. To access the scene files needed to complete the 3ds Max tutorials go to www.autodesk.com/3dsmax-tutorials-scene-files-v2011. To access the scene files needed to complete the 3ds Max Design tutorials go to www.autodesk.com/3dsmaxdesign-tutorials-scene-files-v2011.

For a description of all of the documents related to 3ds Max and 3ds Max Design see the “Documentation Set” topic in the Help available from the Help menu in your product.

Installing and Running the Product

To use the product, you must install the product, register and activate it, and then launch it. You must have administrative permissions to install 3ds Max/3ds Max Design.

This section provides instructions for installing and activating 3ds Max/3ds Max Design for an individual user on a stand-alone computer. For information about deploying 3ds Max/3ds Max Design across a network, see Network Administration and Deployment on page 43.

Installing 3ds Max/3ds Max Design

The 3ds Max/3ds Max Design installation wizard contains all installation-related material in one place. From the installation wizard, you can access user documentation, and install supplemental tools.

To install 3ds Max/3ds Max Design using default values on a stand-alone computer

This is the fastest means of installing 3ds Max/3ds Max Design on a single, stand-alone system. The installation performs the following:

- Uses a Typical installation, which installs the most common application features.
- Installs 3ds Max/3ds Max Design to the default install path of C:\Program Files\Autodesk\3ds Max\3ds Max Design>.

To install the product using default values

1. On the Select the Products to Install page, select your product(s). Click Next.
2 Review the Autodesk software license agreement. Click I Accept, and then click Next.

3 On the User and Product Information page, enter your user information, serial number, and product key. Click Next.
4 On the Begin Installation page, select Install, then answer Yes to the configuration warning message.

NOTE After you click Next, you cannot change the information you entered on this page unless you uninstall the product. Make sure you enter the information correctly.

5 On the Installation Complete page, you can view the installation log and view the 3ds Max/3ds Max Design Readme.

6 Click Finish.

To install 3ds Max/3ds Max Design using customized values on a stand-alone computer

With this method, you can customize your installation.

To install the product using customized values

1 On the Select the Products to Install page, ensure that just the products you want to install are selected, and click Next.

2 Review the Autodesk software license agreement. Click I Accept, and then click Next.

3 On the User and Product Information page, enter your user information, serial number, and product key. Click Next.

NOTE After you click Next, you cannot change the information you entered on this page unless you uninstall the product. Make sure you enter the information correctly.
4 On the Begin Installation page, click Configure.

5 On the Select the License Type page, select the license type: Stand-alone or Network. Click Next.

**IMPORTANT** Make sure to select the correct license type, as you need to completely uninstall and reinstall if you need to switch types.

6 On the Select the Installation Location page, you can change the product install path. You can also view the disk space requirements. Click Next when you are done.

7 On the Mental Ray Satellite page, decide whether to install mental ray satellite (recommended for most users). You can change the mental ray satellite port, though usually the default port is suitable. See Configuring mental ray Satellites on page 29.

8 On the Include Service Packs, page you can decide whether or not to include service packs. See Including Service Packs on page 30.
Components: If you have space limitations, you can elect to install only certain components. On the Autodesk 3ds Max 2011/Autodesk 3ds Max Design 2011 Components tab, Select Installation Type, enable Custom. Turn off the check box of any item you do not want to install. Click Next to continue. See Installing Additional Components on page 25.

11 Once you have customized your settings, click Configuration Complete to return to the Begin Installation page. Then click Install.

**NOTE** If you want a copy of your configuration summary information, click the Copy to Clipboard button.

12 On the Installation Complete page, you can view the installation log or the 3ds Max/3ds Max Design Readme.

13 Click Finish.

You have successfully installed 3ds Max/3ds Max Design. Now you are ready to register your product and start using the program. To register the product, start 3ds Max/3ds Max Design and follow the on-screen instructions. For more details about registering your product see Registering and Activating Your Product on page 18.
Interrupting the Install Process

You can interrupt the install process by clicking Cancel during the installation. You then have the option of resuming the install or exiting. If you exit the installation midway through, you can install the application at another time. You will be prompted to click Finish to exit the Installation Wizard.

NOTE When you interrupt the install, some items that were already installed are removed. Therefore, it may take some time before you can quit the Installation Wizard entirely.

Registering and Activating Your Product

The first time you start your product, the Activation Wizard appears. You can either activate your product at that time or run your product and activate it later. Until you register and enter a valid activation code for your product, you are operating the program in trial mode. The Register Today dialog is displayed for 30 days from the first time that you run the program. If after 30 days of running your product in trial mode you have not registered and provided a valid activation code, your only option is to register and activate your product. Once you register and activate your product, the Register Today dialog no longer appears.

The fastest and most reliable way to register and activate your product is by clicking Activate and activating your product over the Internet. You enter your registration information and it is sent to Autodesk over the Internet. Once you submit your information, registration and activation occur almost instantly.

Obtain an Activation Code Online

With an Internet connection, you can obtain an Activation Code on startup or from the Help menu.

1. Do one of the following:
   - Launch the product. The Activation Wizard appears on startup.
   - If you are already inside the product, select Help ➤ About. In the About [Autodesk Product] window, click Product Information. In the Product Information dialog, click Activate.

2. In the Activation Wizard, click Activate.
This starts the activation process.

3 If you did not enter your serial number and product key during install, enter them and click Next. See Locating Your Serial Number and Product Key on page 9.
4 Click Connect Now and Activate and click Next.

**NOTE** You will be prompted to Login to Autodesk. If you do not already have an account, you will need to create one.

**Enter Your Activation Code to Register Online**

1 Do one of the following:

- Launch the product. The Activation Wizard appears on startup.

- If you are already inside the product select Help ➤ About. In the About [Autodesk Product] window, click Product Information. In the Product Information dialog box, click Activate.
2 On the Product License Activation Options Page, select I have an Activation Code from Autodesk.

**TIP** You can paste the Activation Code, or manually enter all of the values.

3 After you enter the activation code, click Next.

4 On the Product License Activation page, click Finish.

### Offline Registration and Activation

If for some reason online registration and activation is not possible, you can still register and activate your product offline. Contact Autodesk by mail, fax, or phone. Your activation code is sent back to you by mail or fax.

**E-mail** Create an e-mail message with your registration information and send it to Autodesk.

**Fax** Enter your registration information, and fax the information to Autodesk.

**Phone** Provide your registration information to one of our representatives over the phone.

Use the numbers or e-mail address that correspond to your area:

<table>
<thead>
<tr>
<th>Area</th>
<th>e-mail</th>
<th>Fax and Phone Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>United States,</td>
<td><a href="mailto:authcodes@autodesk.com">authcodes@autodesk.com</a></td>
<td>FAX: 800.225.6490 or 415.507.4937</td>
</tr>
<tr>
<td>Canada,</td>
<td></td>
<td>Phone: 800.551.1490</td>
</tr>
<tr>
<td>Latin America</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Europe</td>
<td><a href="mailto:authcodes.neu@autodesk.com">authcodes.neu@autodesk.com</a></td>
<td>Fax: +41 (32) 7239169</td>
</tr>
<tr>
<td>Middle East</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Africa</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Asia Pacific</td>
<td><a href="mailto:ap.register@autodesk.com">ap.register@autodesk.com</a></td>
<td>Fax: +65.6735.4857</td>
</tr>
</tbody>
</table>

Offline registration and activation is necessary under the following conditions:

- An online request has timed out
- A processing error occurred such as an invalid serial number
To register your product offline

1. If you are unable to register online, the Register Today ➤ Connect to the Internet page indicates the reason why online registration and activation failed. Click the Use Another Method link.

2. On the Product Registration page, specify the following:
   - Whether the product will be registered to a company or individual.
   - The country or region where the product will be used.
   - Whether the product is an upgrade. If it is, you also need the previous products serial number.

   Click Next.

3. Enter your personalization data on the Customer Information page, and choose how you would like to receive your activation code: e-mail, fax, or postal mail. Click Next.

4. Review your personalization data on the Confirm Information page, and choose the method you will use to submit your request. Your request can be sent by e-mail, fax, or phone.

   If you choose Send My Request by E-mail, an e-mail message will display for you to complete. If you choose to forward your request by fax or phone, the Contact Autodesk page will display with pertinent contact information.

   You will be sent your activation code by the method you specified on the Customer Information page.

5. If you want to print a copy of your registration information, select the Open Activation Request Form. When you are finished, click Close.

6. You can now enter your Activation code when prompted during the Activation process.

Launch 3ds Max/3ds Max Design

Assuming that you followed all of the previous steps outlined in this installation section, you can launch 3ds Max/3ds Max Design and start taking advantage of its new and updated features. For more detailed information about the new features, as well as learning videos, see the Welcome screen after you launch the product. For Help and Support, see the Help menu.
You can start 3ds Max/3ds Max Design in the following ways:

- **Desktop shortcut icon.** When you install 3ds Max/3ds Max Design, an 3ds Max/3ds Max Design shortcut icon is placed on your desktop. Double-click the 3ds Max/3ds Max Design shortcut icon to start the program.

- **Start menu.** On the Start menu (Windows XP), click Programs or (Windows Vista and Windows 7) All Programs ➤ Autodesk ➤ <3ds Max/3ds Max Design> ➤ <3ds Max/3ds Max Design>.

- **Location where the 3ds Max/3ds Max Design is installed.** If you have administrative permissions, you can run 3ds Max/3ds Max Design in the location where you installed it. If you are a limited-rights user, you must run 3ds Max/3ds Max Design from the Start menu or from the desktop shortcut icon. If you want to create a custom shortcut, make sure that the Start In directory for the shortcut points to a directory where you have write permissions.
Automatic Install of DirectX 9.0c and 10 Updates

For DirectX 9.0c, you must have at least the original version of DirectX 9.0c from Microsoft. If you have Windows XP SP2, you should already have it installed.

For DirectX 10, you must have DirectX 10 and all of the updates from Microsoft. If you are running Windows Vista or Windows 7, you should already have these items installed.

You can download the latest version of DirectX (for DirectX 9.0c or 10) from [http://www.microsoft.com/DirectX](http://www.microsoft.com/DirectX). Choose either the For Gamers or For Pros link and then click Download the Latest DirectX.

When you install Autodesk 3ds Max, a specific set of Direct 3D updates is installed for DirectX 9.0c (June 2007, December 2006, and October 2006) and for DirectX 10 (June 2007 and December 2006). These updates make it possible for DirectX to work with Autodesk 3ds Max.

Installing Multiple or Bundled Products

Some Autodesk packages are comprised of multiple products or are part of multi-product bundles.

In the installation wizard, for packages containing multiple products, you can choose which products you want to install. During the install process, you are informed whether a copy of the software is already installed. You are also warned if your system does not meet the minimum system requirements for the product. Each product name is displayed on its own tabbed panel; you can configure them individually.

If you purchased a package that is a multi-product bundle, such as an educational or institutional package, you might have a package that includes several Autodesk products. For these bundled packages, an Installer disc contains information for all the products in the package. The Installer disc helps you install all of the products. This includes a Readme that describes issues general to the bundle or suite. For install information, read both this install guide and the install information provided with the suite or bundle.
Installing Additional Components

By default, the additional 3ds Max or 3ds Max Design components are installed. The Additional Components include:

- Additional Maps & Materials—Installs a useful base set of maps and materials.

- Essential Skills Movies—Installs the movies which explain introductory 3ds Max/3ds Max Design concepts. These movies are especially useful for users who are new to 3ds Max/3ds Max Design.

- Vault 2009 Plug-in or Vault 2010 Plug-in—
  The Autodesk Vault 2009 and 2010 Plug-ins are used to communicate with the Autodesk Data Management Server. The Autodesk Data Management Server and Autodesk Vault Explorer are available to subscription customers on the subscription Web site (http://www.autodesk.com/3dsmx-subscription). Log in to the Subscription Center and then scroll down to the “Product Information and Downloads” section. Click on the Click Here link under “Autodesk Vault.” On the next page select either 3ds Max 2011 or 3ds Max Design 2011 and follow the instructions.

  Additionally, the Autodesk Data Management Server and Autodesk Vault Explorer are shipped with certain other Autodesk products. If you have the Autodesk Data Management Server and Autodesk Vault Explorer from any of these sources, then you will need the plug-in of the same version. If you do not have the Autodesk Data Management Server and Autodesk Vault Explorer, then you do not need to install the Vault Plug-ins.


Installing Autodesk Backburner 2008.1

Autodesk® Backburner™ is the 3ds Max and 3ds Max Design network-rendering management software, also used by products such as Autodesk® Flame®, and Autodesk® Smoke®.

Autodesk Backburner is a required install. By default, Autodesk Backburner 2008.1 is installed when you install Autodesk 3ds Max/3ds Max Design 2011. In most cases, this is the version of Backburner that you will need.

Two other versions of Autodesk Backburner are available on the DVD: Autodesk Backburner 2011 and Autodesk Backburner 2008.2 IPv6. Use the following
table to determine which version of Autodesk Backburner is appropriate for your situation:

<table>
<thead>
<tr>
<th>Autodesk Backburner Version</th>
<th>Use if:</th>
<th>Install Instructions:</th>
</tr>
</thead>
<tbody>
<tr>
<td>2008.1</td>
<td>You are running a typical install of Autodesk 3ds Max/Autodesk 3ds Max Design 2011 that is not on an IPv6 Network.</td>
<td>Installs by default with Autodesk 3ds Max 2011/Autodesk 3ds Max Design 2011.</td>
</tr>
<tr>
<td></td>
<td><strong>IMPORTANT</strong> Autodesk Backburner 2011 is not compatible with any version of 3ds Max / 3ds Max Design before 2011.</td>
<td></td>
</tr>
<tr>
<td>2008.2 IPv6</td>
<td>Your network is IPv6.</td>
<td>Refer to Backburner_2008_2_(IPv6Only)_Readme.pdf in \support\backburner\IPv6\backburner.</td>
</tr>
</tbody>
</table>

If you're installing 3ds Max or 3ds Max Design on a system that had installations of Autodesk VIZ 2006, 2007, or 2008, Autodesk 3ds Max 8, 9, or 2008, or Autodesk Combustion, an older version of Autodesk Backburner is already installed on the system. You should uninstall previous versions of Autodesk Backburner before you install the new version. If you installed Autodesk 3ds Max 2010 or Autodesk 3ds Max Design 2010, then Autodesk Backburner 2008.1 is detected and will not be installed. Autodesk Backburner 2008.1 is installed by default to the following path: \Program Files\Autodesk\Backburner. Autodesk Backburner 2008.1 is backward compatible so reassigning older jobs to it is not a problem.

For information on using Autodesk Backburner with 3ds Max or 3ds Max Design see the “Network Rendering” section of the Help. For further information about Autodesk Backburner refer to the Autodesk Backburner User’s Guide and Autodesk Backburner Installation Guide which are available from the Help ➤ Additional Help menu in 3ds Max/3ds Max Design.

Autodesk Backburner for Managing and Monitoring Only

You can install Autodesk Backburner on a machine without 3ds Max or 3ds Max Design. However, such an installation of Autodesk Backburner cannot be used for rendering. You can use this machine only to manage or monitor jobs. Although the Autodesk Backburner server can be installed on a single machine, it will not do anything; it will work only if it detects a supported program such as Autodesk 3ds Max, Autodesk 3ds Max Design, Autodesk Flame, or Autodesk Smoke. This means that you must have Autodesk Backburner installed with at least one additional Autodesk product for a machine in your configuration to be capable of rendering.

Installing Autodesk Material Libraries

The Autodesk Material Libraries are shared libraries installed with Autodesk products such as Inventor, AutoCAD, Revit and 3ds Max. These components might be installed already, if one of these applications is already installed.

NOTE If you uninstall or remove a library, the library is no longer available for any products. Uninstalling also means you will be unable to view or display scenes that have Autodesk Materials currently in them.

The Autodesk Material Library consists of three sub-libraries:

- **Autodesk Material Library 2011**: Contains the material appearances used for Realistic Appearance in color styles. This component is installed by default, and it is required for 3ds Max/3ds Max Design to have full visual style and color style functionality. It is recommended you do not uninstall this component unless you are also uninstalling all Autodesk products that require this library.

- **Autodesk Material Library 2011 Base Image Library**: Contains low-resolution (approximately 512 x 512) images for use with Autodesk Materials. This is also installed by default.

- **Autodesk Material Library 2011 Medium Image Library**: Contains medium-resolution (approximately 1024 x 1024) images for rendering materials in medium detail. This library is used for close-ups, and for
rendering objects at a larger scale. This library is an installation option available on the Select Products to Install page in the installation wizard.

Image libraries size:

- **Autodesk Material Library 2011**: Approximately 154MB
- **Autodesk Material Library 2011 Base Image Library**: Approximately 174MB
- **Autodesk Material Library 2011 Medium Image Library**: Approximately 491MB

If you uninstall the Base Image Library, and do not have the Medium Image Library installed, the lowest-resolution library is used (approximately 256 x 256).

When you install 3ds Max/3ds Max Design for the first time, all of the Autodesk material libraries are selected for install by default.

If you uninstall or delete Autodesk Material Library 2011, do the following to reinstall and regain visual style and color style functionality:

- From the product media, browse to and run:
  \MaterialLibrary\CM\ProteinMaterials.msi

If you uninstall or delete the Autodesk Material Library 2011 Base Image Library, do the following to reinstall:

- From the product media, browse to and run:
  \MaterialLibrary\CMI\BaseImageLibrary.msi

If you uninstall or delete the Autodesk Material Library 2011 Medium Image Library, you can reinstall from the product media:

**To reinstall the Medium Image Library**

1. Insert the media. Select Install Products from the installation wizard.
2. On the Select the Products to Install page, select Autodesk Material Library 2011 Medium Image Library, and then click Next.
3. Review the Autodesk software license agreement. Click I Accept, and then click Next.
4. On the User and Product Information page, enter your user information, serial number, and product key. Click Next.
Installing 3ds Max Composite

You can install the 32- or 64-bit version of 3ds Max Composite to use with 3ds Max or 3ds Max Design 2011. By default, 3ds Max Composite is selected for install with 3ds Max/3ds Max Design. 3ds Max Composite includes:

- Raster and Vector Paint
- Image Processing
- Color Correction
- Keying and Rotoscoping
- Stereoscopic Production Support
- Motion Blur
- Advanced 2D Tracking
- Camera Mapping
- Depth of Field
- Node and Layer-based Compositing Options
- Spline-Based Warping
- Enhanced Render Passes
- Data Managing and Collaborating

Configuring mental ray Satellites

mental ray® satellite is installed by default. Click Configure on the Begin Installation page if you wish to change the settings for mental ray satellite or not install it.

A port is selected by default for mental ray network rendering. If the default value does not suit your needs, you can change it to any numerical value between 1 and 65535, but you should do so with caution. Speak with your
system administrator before assigning a new number. You can reset to the default value by entering 0 in the port field.

**Including Service Packs**

On the Include Service Packs page you can:

- Get service packs from autodesk.com. The installer automatically checks autodesk.com for available updates.
- Get service packs from your local machine. You need to specify the locations. Click Add to add a new location.
- Not include service packs.

**Leaving Ports Open**

Autodesk 3ds Max or Autodesk 3ds Max Design, Autodesk Vault, Autodesk Backburner, and various other components of the install, require that certain ports be open in third-party firewalls. If you are having problems with your firewall, read the documentation included with your firewall.

**Windows Theme Support**

Autodesk 3ds Max or Autodesk 3ds Max Design can be customized to inherit the Windows interface theme (this feature supports the Windows XP and XP Classic themes as well as Windows Vista and Windows 7 themes).

When you have chosen your preferred Windows theme, start your software using your normal shortcut. Find information about customization options under the topic, “Customize User Interface Dialog” in Help.

**Customer Involvement Program (CIP)**

The first time you start Autodesk 3ds Max or Autodesk 3ds Max Design, the Customer Involvement Program dialog opens. If you choose to participate in the Customer Involvement Program, 3ds Max or 3ds Max Design will automatically send Autodesk information about your system configuration, what features you use most, any problems that you encounter, and other information helpful to the future direction of the product.
NOTE The CIP does not collect information such as your name, address, phone number, or product serial number without your consent.

Viewing the Essential Skills Movies

When you launch your product for the first time, the Essential Skills Movies splash screen appears. You need Flash to view these movies. When you click to view a movie, you will be prompted to install Flash if you have not done so already.

Watching the Movies from Autodesk.com

You can visit http://www.autodesk.com/3dsmax-essentials or http://www.autodesk.com/3dsmaxdesign-essentials to view the same Essential Skills Movies that are shipped with 3ds Max 2011 and 3ds Max Design 2011.

For more advanced movies that help you move from the Essential Skills Movies to the fundamentals needed to complete the tutorials, watch the How-to Movies at http://www.autodesk.com/3dsmax-howto.
Starting Your Product with Command-Line Switches

You can start your product with special settings using command-line switches. To see a complete list of command-line switches and their functions, see “Starting 3ds Max [Design] from the Command Line” in the Help.

NOTE You might need to activate the program before you can use these commands to start it.

To run your product using a command-line switch

1. Right-click the icon or its shortcut. A shortcut menu appears.
3. In the Target text box, add the command-line switch (in this example -h) after the program path and executable file name. For example: “C:\Program Files\Autodesk\3dsmax2011\3dsmax.exe” -h

   NOTE Ensure the command-line switch is outside of the quotation marks (“”).

4. Click OK. The command-line switch takes effect the next time you run the program from the shortcut.

Graphics Cards and Drivers

When you launch your product, the Direct3D (DirectX) graphics driver is chosen by default. If you have DirectX 9.0c then DirectX 9.0 is selected. If you have DirectX 10 (Vista and Windows 7 only), then DirectX 10 is selected. You can try the different drivers if you are not sure which option gives you the best performance. Choose Windows Start ➤ Programs ➤ Autodesk ➤ 3ds Max/3ds Max Design ➤ Change Graphics Mode.

NOTE If you change the graphics driver, you need to restart 3ds Max/3ds Max Design.
When you find a driver that gives you the best performance, start your software using your normal shortcut. Find information about all the driver options in “Graphics Driver Setup Dialog” in the Help.

For information about supported graphics cards, refer to http://www.autodesk.com/max-hardware.

For troubleshooting tips related to graphics cards, see General Installation Issues on page 61.

Reinstalling, Repairing, and Uninstalling the Product

This section describes how to reinstall, repair, or uninstall 3ds Max/3ds Max Design.
Reinstall or Repair 3ds Max/3ds Max Design

If you accidentally delete or alter files that are required by 3ds Max/3ds Max Design, 3ds Max/3ds Max Design might not perform correctly, and you might receive error messages when you try to execute a command or find a file. You can attempt to fix this problem by reinstalling or repairing 3ds Max/3ds Max Design. The reinstallation or repair uses the features that were part of the installation type you chose when you initially installed the program.

To reinstall or repair 3ds Max/3ds Max Design

1. Do one of the following:
   - (Windows XP) Click Start menu ➤ Settings ➤ Control Panel ➤ Add or Remove Programs.
   - (Windows Vista and Windows 7) Click Start menu ➤ Control Panel ➤ Programs and Features ➤ Uninstall/Change.

2. Then, do one of the following:
   - (Windows XP) In the Add or Remove Programs window, select 3ds Max/3ds Max Design, then click Change/Remove.
   - (Windows Vista and Windows 7) In the Uninstall or Change a Program window, select 3ds Max/3ds Max Design, then click Uninstall/Change.

The 3ds Max/3ds Max Design installation wizard re-opens in Maintenance mode.

3. Select Repair or Reinstall. On the Select Repair or Reinstall page, select one of the following options, and then click Next to start the process.
   - **Repair My <3ds Max/3ds Max Design> Installation.** This option replaces all registry entries that 3ds Max/3ds Max Design initially installed and restores 3ds Max/3ds Max Design to its default state. If you are missing 3ds Max/3ds Max Design files, use this option.
   - **Reinstall My <3ds Max/3ds Max Design> Installation.** This option repairs the registry and reinstalls all files from the original installation. Use this option if the Repair My <3ds Max/3ds Max Design> Installation option does not solve the problem.

Uninstall 3ds Max/3ds Max Design

When you uninstall 3ds Max/3ds Max Design, all components are removed. This means that even if you've previously added or removed components, or if you've reinstalled or repaired 3ds Max/3ds Max Design, the uninstall removes all 3ds Max/3ds Max Design installation files from your system.

To uninstall 3ds Max/3ds Max Design

1. Do one of the following:
   - (Windows XP) Click Start menu ➤ Settings ➤ Control Panel ➤ Add or Remove Programs.
   - (Windows Vista and Windows 7) Click Start menu ➤ Control Panel ➤ Programs and Features ➤ Uninstall/Change.

2. Then, do one of the following:
   - (Windows XP) In the Add or Remove Programs window, select 3ds Max/3ds Max Design, then click Change/Remove.
   - (Windows Vista and Windows 7) In the Uninstall or Change a Program window, select 3ds Max/3ds Max Design, then click Uninstall/Change.

   The 3ds Max/3ds Max Design installation wizard re-opens in Maintenance mode.

3. Click Uninstall.

4. On the Uninstall <3ds Max/3ds Max Design> page, click Next to remove 3ds Max/3ds Max Design from the system.

5. When informed that the product has been successfully uninstalled, click Finish.

NOTE Even though 3ds Max/3ds Max Design is removed from your system, the software license remains. If you reinstall 3ds Max/3ds Max Design at some future time, you will not have to register and re-activate the program.
Tools and Utilities

This chapter describes the items that you can install from the Install Tools and Utilities panel in the 3ds Max/3ds Max Design installer. For install instructions see Installing Tools and Utilities on page 41.
Autodesk 3ds Max 2011 SDK

Information about the Autodesk 3ds Max Software Development Kit (SDK) is available from the Autodesk 3ds Max Developer Center at http://www.autodesk.com/develop3dsmax.

NOTE The SDK is not shipped with Autodesk 3ds Max Design 2011.

Autodesk 3ds Max 2011 SDK Help

If you install the Autodesk 3ds Max 2011 SDK Help, it is installed in CHM format to \maxsdk\help. Also visit http://www.autodesk.com/3dsmax-sdk-docs for further information and updates.

You can use the SDK to create new Autodesk 3ds Max features and tools by writing your own plug-ins.

Autodesk 3ds Max 2011 SDK Help for Visual Studio 2008 SP1

A version of the SDK help has been created that is integrated into the Microsoft® Visual Studio® environment if you install Autodesk 3ds Max 2011 SDK Help for Visual Studio. You should not select this option for install if you do not have Visual Studio installed.

To view the Autodesk 3ds Max 2011 SDK Help from inside Visual Studio

1. Launch Visual Studio.
2. Show the Contents panel.
   Notice a new entry on the Contents panel called: 3ds Max 2011 SDK Help.
3. Expand the 3ds Max 2011 SDK Help entry to view the associated help.

NOTE You can also select the 3ds Max SDK filter using the Filtered By list in Visual Studio to use the Table of Contents, Index, and Search for the entire 3ds Max SDK help collection.
Autodesk Asset Locator

The Autodesk Asset Locator is the Autodesk Product Manager. Autodesk Product Manager searches a network and reports information about each Autodesk product installed, including programs, service packs, extensions, and object enablers. You can save the results of the search in a file for use in a spreadsheet or database application.

You can configure the install path and check the disk space requirements for the Autodesk Asset Locator during the install process. See Installing Tools and Utilities on page 41.

Autodesk Network Licensing Manager (Required for Network Licensing)

In a network licensing setup, the network administrator needs to install the Network Licensing Manager before registering the license online.

Find full details on network licensing in the Licensing Guide (Licensing_3ds_Max.pdf). (Click Documentation in the lower-left corner of the installer.)

- Network Licensing Manager—The Network License Manager is used to configure and manage license servers.

- Network License Activation—To register and activate a network license, you need to go online and use your Autodesk User Account (you can create one if you don’t have one yet) to submit your product information at https://registeronce.autodesk.com. In addition, you can register your product, get automated support by e-mail, and save and migrate license files automatically.

You can configure the install path and check the disk space requirements for the Autodesk Network License Manager during the install process. See Installing Tools and Utilities on page 41.

SAMReport-lite

SAMReport-lite is a reporting tool that helps you track network license usage. You need to obtain a separate license for this tool. Click the Obtain a License link below the SAMReport-lite entry in the Select the Products to Install page.
of the Installation Wizard. Refer to the Autodesk SAMReport-lite User's Guide. (Click Documentation in the lower-left corner of the installer.)

Partners/Plug-Ins

3ds Max and 3ds Max Design include several partner plug-ins.

**WARNING** You need to install and run at least once either 3ds Max 2011 or 3ds Max Design 2011 before installing these plug-ins. This will improve the compatibility of the plug-ins with 3ds Max or 3ds Max Design.

- **ArchVision™ Content Manager**: Used to manage the content acquired using RPC™ Plug-ins.
- **RPC™ Plug-Ins from ArchVision™, Inc. and Sample Content (32- or 64-bit)**: Lets you add photorealistic objects (such as cars, people, and so on).
- **EASYnat™ for Autodesk 3ds Max 2011 (32- or 64-bit)**: Offers a life-like plant modeling solution that allows you to drop virtual seeds from the included samples and “grow” them in your model. Create 2D, 3D, and hybrid models that include branch and leaf detail.
- **TurboSquid™ Tentacles from TurboSquid (32- or 64-bit)**: TurboSquid™ Tentacles is free software you can use to buy and sell digital assets. It provides access to a strong community of graphics professionals and a growing library of over 70,000 models, motion capture files, maps, sounds, plug-ins, and more. For more information, visit the TurboSquid Web site at [http://www.turbosquid.com](http://www.turbosquid.com). It is installed by default during the installation of your product.
- **Craft Director Studio™**: This plug-in provides tools for previsualization and visualization for film, broadcast, and architecture. You can also use it to simulate accidents and crime scenes. For further information see [http://www.craftanimations.com/products/craft-director-studio/overview](http://www.craftanimations.com/products/craft-director-studio/overview).
- **PixelActive® CityScape®**: This plug-in provides tools for the visualization of urban buildings and infrastructure. For further information, see [http://pixelactive3d.com/](http://pixelactive3d.com/).
- **Okino PolyTrans™ and NuGraf™ Demos (32- or 64-bit)**: A demo version of PolyTrans and NuGraf, from Okino Computer Graphics, lets you evaluate dozens of CAD, DCC, and VisSim data converters directly within 3ds Max or 3ds Max Design.
You also need to install the Okino Plug-ins Demo to access PolyTrans and NuGraf from inside 3ds Max or 3ds Max Design.

Autodesk Design Review

Autodesk Design Review is a free program used for creating and reviewing DWF or DWFx files. An open, published, and secure file format developed by Autodesk, DWF enables you to combine and publish rich 2D- and 3D-design data, and share it with others. It is recommended that Design Review be installed if you need to view DWF or DWFx files.

To install Autodesk Design Review go to http://www.autodesk.com/designreview and click Download Now. Note that Autodesk Design Review is not part of the 3ds Max/3ds Max Design 2011 online or DVD installer.

If you are installing Autodesk Design Review 2011, it is recommended that you first manually uninstall older versions of Autodesk Design Review and any other DWF viewers using Add or Remove Programs (XP), or Programs and Features (Vista). After uninstalling, check the program folders to make sure they are empty before installing Design Review 2011.

If you use Windows Vista, you can use the Microsoft XPS Viewer to view and print DWFx files without installing Design Review.

Installing Tools and Utilities

With the exception of Autodesk Design Review, you can install any of the Tools and Utilities mentioned in this chapter using the following procedure. You can install multiple items at once. For information on installing Autodesk Design Review, see Autodesk Design Review on page 41.

1. Click Install Tools and Utilities in the main menu of the Installer.
2. All items are selected by default. Turn off the check box of any item you do not want installed. Click Next.
3 Read and accept the license agreement. Click Next.

4 You can configure some of the Tools and Utilities. Click Configure to:

■ Perform a custom install of the Autodesk 3ds Max 2011 SDK. You can choose not to install the 32- or 64-bit Libraries, the Help files, and the Samples and How-tos.

   **NOTE** All of these items are installed by default if you do not click Configure. The SDK item is not included in the 3ds Max Design Installer.

■ Set the install path and check the disk space requirements for the Autodesk Asset Locator and the Autodesk Network License Manager.

5 Click Configuration Complete when you have finished customizing settings.

6 Click Install. The installation of all selected items begins.
Network Administration and Deployment

Deployment Overview

Read the deployment checklist before starting your deployment to get a general overview of the tasks you need to perform to complete your network deployment. The installer settings for a typical deployment (using default settings) is then described, followed by the settings you might want to change. Finally, information is provided about modifying a pre-existing deployment.

Prepare for a Network Deployment

Complete the following tasks for a network deployment:

Deployment Checklist

☐ Review the system requirements. Confirm your network, servers, and client workstations meet the system requirements. For 3ds Max/3ds Max Design requirements, see Recommended Minimum System Requirements on page 2 and for administrative image requirements, see System Requirements for Administrative Image on page 44.

☐ Decide on the installation type. Choose from Stand-Alone, Multi-Seat Stand-Alone, or Network License. See Choose an Installation Type on page 45.

☐ Understand the type of license you have purchased. For a network license deployment, you should be familiar with the type of license server model you want to use, and the license server names. Refer to the Licensing Guide for complete
Deployment Checklist

- Information about the various licensing options available for deployment. (Click Documentation in the installer.)

- Locate your product serial number and product key. These are located on the outside of the product packaging, or in the Autodesk Upgrade and Licensing Information e-mail message. See Locating Your Serial Number and Product Key on page 9.

- Determine how you intend to personalize the programs during registration. Using consistent registration data is very important.

- Identify the location, and create a shared folder (network share) where deployments will reside for each program you plan to deploy. See Create a Network Share on page 46.

- Close all other programs and disable anti-virus software.

- Determine whether your deployment plan involves using imaging software to distribute your programs to client workstations. Refer to the documentation that accompanies your imaging software.

- Determine if you need to configure special settings during the install. See Items You Can Configure on page 48.

- Create either your default or custom deployment. (See Create a Default Deployment on page 54 or Create a Custom Deployment on page 56).

- Point users to the administrative image that you created. See Point Users to the Administrative Image on page 60.

System Requirements for Administrative Image

This section contains the system requirements for the location of the administrative image.

Before you begin installing the program on a network, make sure that your servers and client workstations meet the minimum recommended hardware and software requirements for a deployment. For complete system requirements, see Recommended Minimum System Requirements on page 2.
See the following tables for administrative image system requirements.

<table>
<thead>
<tr>
<th>Hardware Requirements-Administrative Image Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hard disk</td>
</tr>
</tbody>
</table>

**Choose an Installation Type**

When you set up your deployment, you need to choose the type of installation to deploy. In the 3ds Max/3ds Max Design Deployment wizard, you specify one of the following installation types:

**Stand-Alone installation (Stand-Alone option)** Choose this type of installation for stand-alone installations where a single serial number and product key are used for a single seat. Like a multi-seat stand-alone installation, you do not use the Network License Manager to manage product licensing, but installation, registration, and activation occurs on each workstation.

**Multi-Seat Stand-Alone installation (Stand-Alone option)** Choose this type of installation for stand-alone installations where a single serial number and product key are used for multiple seats. Multi-seat stand-alone installations do not rely upon the Network License Manager to manage product licenses; however, you can still use the 3ds Max/3ds Max Design Deployment wizard to create administrative images and deployments. Registration and activation is more automated for multi-seat stand-alone installations. After the first activation using the multi-seat stand-alone serial number and product key, activation occurs automatically for all workstations based on this deployment, as long as your systems are connected to the Internet.

**Network License installation** With this type of installation, you install the program to workstations with the files and registry entries that allow the program to communicate with the Network License Manager. You also define the configuration of the Network License Manager so that the licenses can be accessed. Workstations running the program based on a network installation do not require individual activation. Licensing of this program is managed by at least one license server.

The main advantage is that you can install 3ds Max/3ds Max Design on more systems than the number of licenses you have purchased (for example, purchasing 25 licenses but installing on 40 workstations). At any one time,
3ds Max/3ds Max Design runs on the maximum number of systems for which you have licenses. This means you get a true floating license.

Create a Network Share

Once you have fully prepared for creating a deployment, you are ready to set up and distribute 3ds Max/3ds Max Design by creating a network share location (folder). A network share is an installation folder that you make available to users' computers on a network. You point users to this location to install the program.

A network, shared folder is required for network license and multi-seat stand-alone methods of installation. Any subfolders that are placed inside a network shared folder are automatically shared.

NOTE You must have Full Control permissions set for your shared folder when you are creating your deployment images. Read permissions are necessary to access the network share and administrative permissions on the workstation where the program is deployed.

To create a network share folder

1. On your network server's desktop, create a folder named Deployments.
2. Right-click the Deployments folder and click Share and Security (or Sharing).
3. In the <folder name> Properties dialog box, Sharing tab, select Share This Folder.
4. Specify a Share Name, such as Deployments, if necessary.
5. Click the Permissions button. In the Permissions dialog box enter your group or user names, and make sure Full Control is selected. Click OK. In Vista, right-click the Deployments folder and then click Share. In the File Sharing dialog box type in or browse to the name of the group or user you want to share the folder with. Click Add, and then click Share.
6. For each product you plan to install, create a subfolder in the Deployments folder. Name each folder with the pertinent product name.
Network Tools and Your License Server

If users are running the program using network licenses, you need to use the Network License Manager. The Network License Manager helps you configure and manage license servers. For information about installing and setting up the Network License Manager and licensing tools, see the Autodesk Licensing guide.

Configure Your Deployment

You can create a deployment that uses the default product settings, or you can configure each product to be included in the deployment. To configure a product, on the Create Deployment page of the deployment wizard, select the appropriate product from the drop-down list, and click Configure.

**TIP** If you have a Network License, you need to click Configure to choose Network License. Otherwise you have the default, Stand-Alone License and you will need to completely uninstall and reinstall to choose Network License.

The following configuration options are available. See Items You Can Configure on page 48 for details about these options.

- Select the License Type (Stand-alone or Network license)
- Configure the Install Location
- Select the Installation Type (Typical or Custom)
- Configure mental ray
- Install Additional Files
- Include Service Packs

When you finish selecting options, click Configuration Complete. The Create Deployment page is redisplayed, where you can confirm your selections. Click Create Deployment.

**NOTE** To retain a copy of your settings, click Copy to Clipboard.

If you do not want to make configuration changes on the Create Deployment page, click Create Deployment.
Items You Can Configure

When you create a deployment, you will make several choices during the process to create various client deployment images and deployment types. The following sections outline your choices in more detail.

NOTE You must click Configure on the Create Deployments page to be able to change these settings.

Enter User and Product Information

The User and Product Information page is used to personalize the program for your environment. The information you enter is permanently retained with the product and is displayed in the Help menu on all workstations. Because you can't change this information later without uninstalling, take care when entering the information.

You must also enter the product serial number and product key in order to run the product. The serial number and product key are located on the outside of the product packaging, or in the Autodesk Upgrade and Licensing Information email. The serial number must contain a three-digit prefix followed by an eight-digit number. The product key consists of five characters.

Your clients can review this product information later, on the InfoCenter toolbar, click the drop-down arrow next to the Help button (the question mark). Then click About - Product Information.
Creating Log Files

From the General Deployment Settings dialog, you can setup two types of log files with which you can monitor information about deployments and installations.

- **Create network log** The network log file keeps a record of all workstations that run the deployment. On the General Deployment Settings page, you choose whether or not to create a network log file. The log lists the user name, workstation name, and the status of the installation. Refer to this file for status information and details about problems that users encountered during installation (for example, low disc space or inadequate permissions).

  The network log is named with the same name you chose for your deployment. You can specify where the log file is created by entering either a valid UNC (universal naming convention) path or hard-coded path on your network, for example `\MyComputer\Autodesk\<Autodesk product>`. Users should use their actual computer name in place of `MyComputer`.

  **NOTE** The folder where the network log resides must be a shared folder where users who install the program have Change permissions. Otherwise, successes or failures for user installations cannot be written to the log file.

- **Create client log** The client log contains detailed installation information for each workstation. This information may be useful in diagnosing installation problems. The client log is located in the `%Temp%` directory of each client workstation.

![General Deployment Settings](image)

What Is Silent Mode?

When silent mode is active and a user initiates the deployment, the installation proceeds without any explicit user input. Users cannot change any of your
installation settings. No dialog boxes are presented that require interaction from the user.

**WARNING** When the product is installed from a deployment using silent mode, users’ systems will reboot automatically and without warning when the installation is complete.

Choose a License Type

You must click Configure to change the license type to Network. By default, Stand-alone License is selected. Refer to the *Licensing Guide* for information on choosing a license type. (Click Documentation in the lower-left corner of the installer.)

Location of Installs and Disk Space Requirements

You choose the location where 3ds Max/3ds Max Design, Backburner, and Components are installed on the client workstation in the Product Install Path. To help decide where the product is installed, a chart of drives and disc space is provided.

Configuring mental ray Satellites

For information on configuring the mental ray satellites, see *Configuring mental ray Satellites* on page 29.

Install Additional Files (Optional)

On the Install Additional Files page, when you click Browse, you can specify additional files to include with a deployment. By default, these files are installed in the program's installation directory on client workstations when the deployment is run. You can install files to multiple directories if desired.

You can perform the following operations:

- Specify additional files to include with your deployment.
- Install user files, of any format, and place them in any directory on the client's workstation.
- Add subfolders under the installation folder (for example, a folder called LSP to contain custom AutoLISP routines).
- Add files to the same location as program files (for example, add sample scenes for a project).
- Add files to the root of the installation directory.

**NOTE** It is recommended that you install these files to a location within the program's directory structure. You cannot install a file that has the same name as an installed program file. For example, you cannot add a file named `acad.cui`.

### To install additional files

1. While creating a deployment, on the Install Additional Files page, set the location where the files will be installed.
2  Do any of the following:
   ■ Click Browse to open the Add Files dialog box, where you can select files to add to the installation directory.
   ■ Click Add Folder to create a new folder in the installation directory.
   ■ Click Add Drive to add a drive name to the file location structure. The drive name must be a valid drive letter and colon, for example C: or F:. Uniform Naming Convention (UNC) paths are not supported.
   ■ Click Remove to delete a file, folder, or drive from the installation directory.

3  Click Next.

Include Service Packs (Optional)

You have the option to include service packs for your product. You can select to download and apply a service pack from autodesk.com, or choose to use a locally stored (local hard drive or local network) service pack. In either case, the service pack will be applied only after the installation of the main product is completed.

If you select the Install Service Pack from autodesk.com button, the service pack will be automatically downloaded and you will not need to extract the MSP file.

If you choose to include a service pack from a local or network drive, you will need to plan how you want the service pack handled from the two options below. You will also need to complete the following steps.

NOTE  If the deployment process for the main product is canceled or fails, the service pack installation will automatically be canceled.
Append the Service Packs onto the Deployment. When you append a service pack, the service pack is applied to the current deployment only. Multiple service packs may be appended to a deployment. The service pack file is included in the deployment and the service pack is applied after the product is deployed.

Merge the Service Packs into the Administrative Image MSI File. When you merge a service pack, the service pack is merged into the administrative image. Once merged, a service pack may not be removed from the administrative image. Multiple service packs may be included in a single administrative image.

To extract a Microsoft Installer Patch (MSP) file from a service pack:

1. Download the service pack from the 3ds Max/3ds Max Design support site.
2. Review the service pack Readme file for information about patch usage.
3. Open a Windows command prompt and enter the patch file name followed by the /e switch and a target file name, such as:

   `ProductSP1.exe /e ./ProductSP1.msp`
where `<ProductSP1.exe>` is the name of the downloaded patch and `<ProductSP1.msp>` is the name of the extracted file. Using ‘./’ in front of the extraction file name places the extracted file in the same folder as the original executable. The “e” command line switch extracts the MSP file from the executable.

To include a service pack with the deployment

To include a service pack with a deployment, an MSP file must be extracted from the downloaded service pack executable.

1. On the Include Service Packs page, click the Browse button.
2. In the Open dialog box, locate the service pack you want to include with the deployment.
3. Select the MSP file and click Open.
4. Specify whether you want to append the service pack to the deployment or merge the service pack into the administrative image.
5. Click Next.

Components: Select Typical or Custom

If you have space limitations, you can elect to install only certain Components. On the Autodesk 3ds Max 2011/Autodesk 3ds Max Design 2011 Components tab | Select Installation Type, enable Custom. Turn off the check box of any item you do not want to install. Click Next to continue. See Installing Additional Components on page 25 for information about the different components.

Create a Default Deployment

If you do not plan to customize your deployment, you can create a default deployment.

The following procedure illustrates how quickly you can set up a default deployment using the deployment wizard. This procedure illustrates a single-server network deployment using a Typical installation with no customizations. For information about customizing product configurations in a deployment, see Create a Custom Deployment on page 56.
To create a deployment using default settings

1. Start the 3ds Max/3ds Max Design Installation wizard.
2. On the initial page, click Create Deployments.
3. On the Begin Deployment page, specify the following:
   - **Administrative Image Field.** Enter or locate the path to the shared network location where you want to create and store your administrative image. Users install the program from this location.
   - **Deployment Name Field.** Enter the new deployment’s name. This name is used for the shortcut from which users will install the product.
   - **This is to be a:** Select either 32-bit or 64-bit for your target operating system.
     Click Next.
4. On the Select the Products to Include in the Deployment page, select the products to include in your deployment. Click Next.
5. Review the Autodesk software license agreement. Click I Accept, and then click Next.
6. On the User and Product Information page, enter your user information, serial number, and product key. Click Next.
   **WARNING** After you click Next, you cannot change the information you entered on this page unless you uninstall the product.
7. On the General Deployment Settings page specify whether to:
   - **Create a network log file.** Specify the log file’s location by entering either a valid UNC (universal naming convention) path or a hard-coded path on your network.
     **NOTE** The folder that contains the network log file must be a shared folder for which users who install the program have Change permissions. Otherwise, successes or failures for user installations cannot be written to the log file.
   - **Create a client log file.**
Run the installation in silent mode to prevent users from changing installation settings.

For more information on log files, see Creating Log Files on page 49. For more information on silent mode, see What Is Silent Mode? on page 49.

Click Next.

8 On the Create Deployment page, click Create Deployment. Click Yes to continue creating the deployment using the default configuration.

An administrative image is created in your shared folder using the deployment options listed in Current Settings. To retain a copy of your deployment settings, click Copy to Clipboard.

9 On the Deployment Complete page, click Finish.

Create a Custom Deployment

To alter your deployment by removing features or restricting access to online resources, customize the configuration of each product included in the deployment.

To create a custom deployment

1 Start the 3ds Max/3ds Max Design Installation wizard.

2 On the initial page, click Create Deployments.

3 On the Begin Deployment page, specify the following:
   ■ Administrative Image Field. Enter or locate the path to the shared network location where you want to create and store your administrative image. Users install the program from this location.

   NOTE For information on how to create a network share, see Create a Network Share on page 46.

   ■ Deployment Name Field. Enter the new deployment's name. This name is used for the shortcut from which users will install the product.

   ■ This is to be a: Select either 32-bit or 64-bit for your target operating system.

   Click Next.
4 On the Select the Products to Include in the Deployment page, select the products, and language to include in your deployment. Click Next.

5 Review the Autodesk software license agreement. Click I Accept, and then click Next.

6 On the User and Product Information page, enter your user information, serial number, and product key. Click Next.

**WARNING** After you click Next, you cannot change the information you entered on the this page unless you uninstall the product.

7 On the General Deployment Settings page specify whether to

  ■ Create a network log file. Specify the log file's location by entering either a valid UNC (universal naming convention) path or a hard-coded path on your network.

  **NOTE** The folder that contains the network log file must be a shared folder for which users who install the program have Change permissions. Otherwise, successes or failures for user installations cannot be written to the log file.

  ■ Create a client log file.

  ■ Run the installation in silent mode to prevent users from changing installation settings.

  For more information on log files, see Creating Log Files on page 49. For more information on silent mode, see What Is Silent Mode? on page 49. Click Next.

8 On the Create Deployments page, click Configure to customize the product configuration.

9 On the Select the License Type page, select Stand-alone or Network license, then click Next.

10 On the Select the Installation Location page you can change the product install path. You can also view the disk space requirements, then click Next.

11 On the Mental Ray Satellite page, decide whether to install mental ray satellite (recommended for most users) and you can change the mental ray satellite port, though usually the default port is suitable. See Configuring mental ray Satellites on page 29.
12 On the Install Additional Files page, specify the installation location and the file names of any additional files you want to include in the deployment. Click Next.

13 On the Include Service Packs page, specify whether to include any available service packs. The installer automatically checks autodesk.com for available updates.

14 Autodesk 3ds Max 2011/Autodesk 3ds Max Design 2011 [32- or 64-bit] Components: If you have space limitations, you can elect to install only certain Components. On the Autodesk 3ds Max 2011/Autodesk 3ds Max Design 2011 Components tab Select Installation Type, enable Custom. Turn off the check box for any item you do not want to install. Click Next to continue. See Installing Additional Components on page 25.
15 On the Configuration Complete page, select a product tab to configure another product, or click Configuration Complete to review your settings.

16 On the Create Deployment page, click Create Deployment. To retain a copy of your deployment settings, click Copy to Clipboard.

17 On the Deployment Complete page, click Finish.

Modify a Deployment (Optional)

After a deployment is created, it may be necessary to modify the deployment for some client workstations. You can apply a patch or include various custom files that are not part of the base administrative image. You can also perform modifications such as changing the installation directory from drive C to drive D.

To modify a deployment

1 Open the shared network folder where you originally chose to place your product deployment.
2  In the Tools folder, double-click the Create & Modify a Deployment shortcut. The deployment wizard is redisplayed.

3  Click through the deployment pages and make the necessary changes.

4  Click Create Deployment.

**Point Users to the Administrative Image**

When you are done creating the deployment, users can install the program using the shortcut located with the administrative image. The shortcut name matches the deployment name that you specified in the deployment wizard. Notify users of the location of the administrative image, instruct them to double-click the shortcut, and provide any other necessary instructions.
This section provides solutions to installation issues and answers to commonly asked questions that may arise while installing your product(s). Additional troubleshooting information and support is also available at http://www.autodesk.com/3dsmax-support and http://www.autodesk.com/3dsmaxdesign-support.

General Installation Issues
This section outlines common issues and their solutions that may arise while performing a general install of your product(s).

How can I check my graphics card driver to see if it needs to be updated?

It is recommended that you verify and update your graphics card driver if a new version is available. Doing so can improve system stability and performance while using 3ds Max or 3ds Max Design. Use the following procedure to identify your current graphics card driver.

To check if new drivers are available (Windows Vista or Windows 7, Classic View)

1. On the Start menu click Control Panel.
2. Click Appearance and Personalization.
3. Click Personalization.
4. Open Display Settings and click Advanced Settings.
5. Click the Adapter tab to check the adapter type.
6 Click the Properties button and open the Driver tab to check driver version and see if newer drivers are available.

To check if new drivers are available (Windows XP)

1 On the Start menu, click Settings ➤ Control Panel.
2 Click the Display icon to access the Display Properties.
3 Open the Settings tab and click the Advanced button.
4 Click the Adapter tab to check the adapter type.
5 Click the Properties button and open the Driver tab to check driver version and see if newer drivers are available.
What should I do if I run into graphics card issues during startup?

If you run into any issues related to your graphics card during startup, it is recommended that you confirm that you have the correct DirectX drivers (see Recommended Minimum System Requirements on page 2) and also refer the Video Driver and Display Problems topic in the Help file. In 3ds Max/3ds Max Design go to Help ➤ Autodesk 3ds Max/Autodesk 3ds Max Design Help.

What is the benefit of using a network licensed version of the software?

Network licensed products are recommended for large facilities, classrooms, and lab environments. The main advantage is that you can install products on more systems than the number of licenses you have purchased (for example, purchasing 25 licenses but installing on 40 workstations). At any one time, products will run on the maximum number of systems for which you have licenses. This means you get a true floating license. If software needs to be run on more systems, additional licenses can be purchased.

How do I access my product documentation?

The 3ds Max/3ds Max Design Help and Tutorials are available from the Help menu in your product. This includes the help for Autodesk Backburner and mental ray. See the Documentation Set topic in the Help for a complete description of these items.

The install and licensing documentation are available in the installer. Click Documentation in the bottom left corner of the installer or Read the Documentation on the first page of the Installer.
What is SAMreport-lite?

SAMreport-lite is a report generator that helps you monitor the usage of applications that use FLEXnet™. SAMreport-lite complements FLEXnet by providing a graphical user interface (GUI) from which to run usage reports. SAMreport-lite can help you make better decisions about your software assets. For more information, see the SAMreport-lite User’s Guide available by clicking Documentation in the Installer.

Deployment Issues

This section outlines common issues and their solutions with regards to software deployments.

Where can I find the Deployment Checklist?

See Prepare for a Network Deployment on page 43.

Where can I check if service packs are available for my software?


How do I extract an MSP file?

A Microsoft Patch (MSP) file is usually contained in a Service Pack executable that you download from 3ds Max/3ds Max Design Support website. To extract the MSP file from the executable, run the patch program from the Windows command prompt using the /e switch.

Pay particular attention to the location where the files are extracted. For details about using the patch file, review the Readme file for that patch.
Where can I learn about InfoCenter, including search locations?

You can use InfoCenter to enter a question for help, display the Communication Center panel for product updates and announcements, or display the Favorites panel to access saved topics. For more information, refer to InfoCenter in the Help.

What are information channels?

The Communication Center component of InfoCenter allows you to receive announcements from various information channels. Through information channels, you can receive the following:

- Product Support information, including maintenance patch notifications.
- Subscription Center announcements and subscription program news, as well as links to e-Learning Lessons, if you are an Autodesk subscription member.
- Notifications of new articles and tips posted on Autodesk websites.

What are RSS feeds and how do they benefit my installation?

An RSS feed is a live link you initiate by subscribing to someone’s website. Once subscribed, the primary benefit is a constantly updating stream of content that is delivered to your system in the form of summarized articles, forum threads, blog posts, and so on. RSS stands for Rich Site Summary (or Really Simple Syndication). Refer to “Specify InfoCenter Settings” in the 3ds Max/3ds Max Design Help. In 3ds Max/3ds Max Design go to Help ➤ Autodesk 3ds Max/3ds Max Design Help.

Networking Issues

This section outlines common issues and their solutions with regards to performing a network installation or configuring your network license server(s).
Where do I find my server name?

When installing a network licensed product, you must specify the name of the server that will run the Network License Manager. If you don’t know the server name, you can quickly find it by opening a Windows command prompt on the system that will be the Network License Manager. At the prompt, enter `ipconfig /all` and note the Host Name entry.

What is an administrative image (MSI) file?

An administrative image is a collection of shared file resources created during the deployment process and is used by deployments to install the program to networked workstations. Service packs (patches) can be applied to an administrative image when you create the deployment. A `.msi` file is a Microsoft Installer file.

What is the impact of selecting all products for the administrative image, and can I add products later?

The image size remains constant regardless of selections, because all items are always included in the image.

If you later want to deploy items that you did not select originally, simply modify your existing deployment.

Uninstall and Maintenance Issues

This section outlines common issues and their solutions with regards to adding and removing features, reinstalling or repairing your installation, and uninstalling products.

Is it possible to change the installation folder when adding or removing features?

Once your product is installed, you cannot change the installation path from the Add/Remove Features page. Changing the path while adding features results in program corruption, so it is not an option.
When should I reinstall the product instead of a repair?

You should reinstall your product if you accidentally delete or alter files that are required by the program. Missing or altered files adversely affect the performance of your product and cause error messages when you try to execute a command or find a file.

If an attempt to repair an installation fails, reinstalling is the next best option.

Do I need my original disc(s) to reinstall my product?

When performing a reinstall of the product, you are prompted to load your original disc(s). Installation data is cached locally on your drive and that data is reused when reinstalling.

When I uninstall my software, what files are left on my system?

If you uninstall the product, some files remain on your system such as files you created or edited.

Your license file also stays on your workstation when you uninstall your product. If you reinstall on the same workstation, the license information remains valid and you do not have to reactivate the product.
activate Part of the Autodesk software registration process, it allows you to run a product in compliance with the product’s end-user license agreement.

administrative image A collection of shared file resources created by the deployment wizard and used by deployments to install the program to network workstations.

deploy The process of installing an Autodesk product to one or more computers on a network.

deployment A link to a unique MST (Microsoft Transform) file that serves as a basis for an installation. Using the deployment wizard, administrators can create multiple deployments that result in different types of installations for users.

directory service A network service that identifies all resources on a network and makes them accessible to users and applications. Resources include e-mail addresses, computers, and peripheral devices such as printers. Ideally, the directory service should make the physical network topology and protocols transparent so that a user on a network can access any resource without knowing where or how it is physically connected. Virtually all directory services are based on the X.500 ITU standard.

FLEXnet License management technology from Acresso™ Software, Inc. FLEXnet provides administrative tools that help to simplify management of network licenses. FLEXnet can be used to monitor network license status, reset licenses lost to a system failure, troubleshoot license servers, and update existing license files.

group policy Microsoft server technology that provides a way to do push installations and advertising-based installations using standard Microsoft 2000 Server administration components.

installation image A deployment that consists of an MSI file, any associated transforms, additional user-specified custom files, and profile and registry settings.
**License Transfer utility** Allows you to use an Autodesk product on more than one computer without purchasing a separate license for each computer.

**MSI** Microsoft installer that supports a variety of parameters that can be scripted.

**MSP** Microsoft patch file (see patch).

**MST** Microsoft transform file. Modifies the components installed by the MSI file. For example, the deployment wizard creates an MST file with the settings that you specify. The deployment created by the deployment wizard uses the MST file in conjunction with the MSI file and MSIEXEC to install the program on local workstations.

**multi-seat stand-alone installation** A type of installation where multiple stand-alone seats of the program are installed using a single serial number.

**network license installation** A type of installation where you install the program to workstations with the files and registry entries that allow the program to communicate with the Network License Manager.

**partial profile** A profile that contains partial registry information corresponding to a subset of the options available from the Files tab of the Options dialog box.

**patch** A software update to an application.

**power user** A user with rights to access and write to the *Program Files* folder and the *HKEY_Local_Machine* folder of the registry.

**service pack** Autodesk terminology for an application patch.

**silent mode** An installation that proceeds without any explicit user input. No dialog boxes are presented that require interaction from the user.

**transform** See MST.
Index

32- and 64-bit combinations  6
3ds Max and 3ds Max Design, differences  1
3ds Max Composite  29
   supported operating systems  3

A
   activating  18
   Additional maps & materials  25
   administrative image
      size of  66
      system requirements  44
   administrative images
      defined  66
      shortcuts to  60
   administrator permission requirements  8
   applications
      uninstalling  66
   ArchVision  40
   Autodesk 3ds Max SDK  38
   Autodesk Asset Locator (Autodesk Product Manager)  39
   Autodesk Backburner  25
   Autodesk Channels  65
   Autodesk Design Review  41
   Autodesk Material Libraries  27
   Autodesk Network Licensing Manager  39

B
   Backburner  25
   bundles  24

C
   checklist, deployments  43
   CIP (Customer Involvement Program)  30
   client log files  49
   closing running applications  10
   command line, starting from  32
   components  25
   Craft Director Studio  40
   custom installation  14

D
   default installation  12
   deployments
      checklist  43
      choices  48
      configuring  47
      custom  56
      default  54
      issues  64
      modifying  59
      overview  43
   Design Review  41
   DirectX  24
   documentation resources  10
   drivers  32

E
   EASYnat  40
   email registration  21
   Essential Skills Movies  31

F
   fax registration  21

G
   glossary  70
   graphics cards  32
   troubleshooting  61

H
   hardware requirements  4
Index

RPC 40
RSS feeds 65

S
SAMreport-Lite 39, 64
SDK (including help) 38
serial numbers
stand-alone installation 9
servers 66
service packs 30, 52
shortcuts
administrative images 60
creating 23
silent mode 49
software deployments 64
software requirements 3
stand-alone installations 1
process 12
selecting 45
starting 22
from command line 32
suites 24
support resources 10
swap-file size 7
system requirements 2
administrative image 44

Mac 8

T
tools and utilities 37
installing 41
troubleshooting 61
network license 63
TurboSquid Tentacles 40

U
uninstalling 35
remaining files 67
uninstalling programs 66
user information 48

V
Vault 25
videos 31

W
Windows Theme Support 30
Contents

Chapter 1  Stand-Alone Licensing ................................. 1
  Introduction .................................................. 1
  Multi-Seat Stand-Alone License ......................... 1
  Activate Your Product .................................... 2
  Register Your Product .................................. 2
  Manage Your Stand-Alone License .................... 2
    Check Product Information .......................... 2
    View Product Information ........................... 3
    Save License Information as a Text File ........... 4
    Update Your Serial Number ........................ 4
  Transfer Your Stand-Alone License ........................ 5
    About the License Transfer Utility .................. 5
    Install the Autodesk Product ........................ 6
    Export a License ..................................... 6
    Import a License ..................................... 7
  Troubleshoot a Stand-Alone License Error ............. 9
    Hardware Changes .................................... 9
    Reinstalling an Operating System ..................... 9
    Changing the System Date and Time .................. 10
    Distributing Software Image to Multiple Computers 10
    Preserving Licenses on Re-Imaged Computers ......... 11

Chapter 2  Network Licensing ................................. 13

iii
# Plan Your Network Licensing

13

# System Requirements for the Network License Manager

13

# Plan Your License Server Configuration

15

- Single License Server Model
- Distributed License Server Model
- Redundant License Server Model

# Learn About Your License

17

- License Operation and Availability
- License Files
- License File Examples
- Package License File Examples
- License Types and Behaviors
- Heartbeat Signal

# Network License Manager

31

- Install the Network License Manager
- Obtain a License Through autodesk.com
- Obtain the Server Host Name and Host ID Manually
- Configure a License Server
- Install SAMreport-Lite (Optional)
- Uninstall the Network License Manager

# Network Licensing Tools

36

- FLEXnet Configuration Tools
- Utilities for License Server Management
- Stop and Restart the License Server
- Update FLEXnet from a Previous Version
- Set Up and Use an Options File

# License Borrowing

44

- Overview
- Borrow a License
- BORROWLICENSE Command
- Return a License
- RETURNLICENSE Command

# Network Licensing FAQs

48

- What is the difference between a stand-alone license and a network license?
- What is the benefit of using a network licensed version of the software?
- What is Internet Explorer used for?

# Glossary

51

# Index

55
Stand-Alone Licensing

Introduction

A stand-alone license allows you to run an Autodesk® product on a single workstation.

Stand-alone licensing allows you to use your Autodesk product in trial mode for a given number of days from the first time you launch the product. The number of days that a trial mode is active differs between Autodesk products. You can activate your license at any time before the trial period expires.

When you activate your product, you receive an activation code. If you activate online, your activation code is automatically retrieved from Autodesk and the product starts. Activations are also available through e-mail, fax, phone, or the Autodesk website.

NOTE If you are installing and using an Autodesk product on both operating systems of a dual-boot operating system, you must obtain a separate activation code for each operating system.

The license file stays on your workstation when you uninstall your product. If you reinstall your Autodesk product on the same workstation, the license information is still valid. You do not have to reactivate the product.

Multi-Seat Stand-Alone License

A multi-seat stand-alone license allows you to install, register, and activate an Autodesk product on several workstations using a single serial number. Multi-seat licenses can be purchased through your Authorized Autodesk Reseller.
The Create Deployment feature in the provided installer simplifies deployment by creating a server image that you can access to install the software on your workstation. The software activates automatically when it is started for the first time and if an Internet connection is available.

**NOTE** To avoid activation failures, it is recommended that you use the provided installer to create the deployment server image.

## Activate Your Product

You can activate your Autodesk product either on startup or while you are running the product. If you cannot activate online, offline activation is available. For complete details on activation, refer to the *Autodesk 3ds Max 2011 and Autodesk 3ds Max Design 2011 Installation Guide* available from the Documentation link in the installer.

## Register Your Product

Depending on your product, registration is optional or required. If required, you are asked to create a user Autodesk ID and associate this ID with an individual or company account. If registration is optional, you can choose to postpone it, and you will be reminded periodically to register. For complete details on registration, refer to the *Autodesk 3ds Max 2011 and Autodesk 3ds Max Design 2011 Installation Guide* available from the Documentation link in the installer.

## Manage Your Stand-Alone License

This section provides information about advanced stand-alone licensing tasks such as license types and behaviors, viewing product information, saving your license file as a text file, updating your serial number, and transferring a license.

## Check Product Information

You can view detailed information about your Autodesk product and your product license (such as the license usage type and the license behavior), and then save this information as a text file.
License usage types

NOTE All license types are available as stand-alone and network except for the Student Portfolio license, which is available as stand-alone only.

Commercial A license for a product that was purchased commercially.

Not for Resale A license for a product that is not sold commercially.

Educational (EDU)/Institution A license designed specifically for educational institutions.

Student Portfolio A license for students who are using an Autodesk product as part of their curriculum.

License behaviors

Trial A license that allows individuals to try the product in trial mode for a specified number of days. The trial period starts the first time you launch your product. When the trial period expires, the product must be registered and activated to continue use.

Permanent Allows permanent use of an Autodesk product.

Term Extendable Allows access to an Autodesk product for a limited time. The term can be extended at any time.

Term Non-Extendable Allows access to an Autodesk product for a limited time. The term cannot be extended.

View Product Information

You can view detailed information about your Autodesk product and your product license, such as the license usage type and the license behavior.

To view product information

1. Launch your Autodesk product.

2. On the Help menu, click About.

3. In the About [Autodesk Product] window, click Product Information.

4. In the Product Information dialog box, view details about your product and the product license.

5. In the Product Information dialog box, click Close.
Save License Information as a Text File

You can save your product license information as a text file.

To save license information as a text file
1. Launch your Autodesk product.
2. On the Help menu, click About.
3. In the About [Autodesk Product] window, click Product Information.
4. In the Product Information dialog box, click Save As.
5. In the Save As dialog box, name the file, choose a location where you want to save the file, and then click Save.
6. In the Product Information dialog box, click Close.

Update Your Serial Number

Your valid serial number is located on the outside of the product packaging or in the Autodesk Upgrade and Licensing Information e-mail you received if you downloaded your product.

When you register and activate your product, you are asked for the product serial number, which is automatically entered upon completion of the activation process.

If you have a multi-product bundle of software that uses a single serial number, only the first product you register and activate displays the updated serial number. For other products to display the serial number, you must update it from the Help menu.

NOTE For the updated serial number to display, you must be logged into the system with Administrator rights.

To update your serial number
1. Launch your Autodesk product.
2. On the Help menu, click About.
3. In the About [Autodesk Product] window, click Product Information.
4. In the Product Information dialog box, click Update.
5 In the Update the Serial Number dialog box, enter your product serial number.

The serial number is located on the outside of the product packaging or in the Autodesk Upgrade and Licensing Information e-mail you received if you downloaded your product.

NOTE If you have lost your serial number, contact the Autodesk Business Center (ABC) at 800-538-6401 for assistance.

6 Click OK. You can now see the updated serial number.

Transfer Your Stand-Alone License

You can use an Autodesk product on more than one computer without purchasing a separate license for each computer. License transfers are only supported on products that require the creation of an Autodesk ID as part of the registration and activation process.

About the License Transfer Utility

The License Transfer Utility transfers a product license online from one computer to another, and ensures that the product works only on the computer that contains the license. The License Transfer Utility is a custom stand-alone installation option. During installation, a shortcut is created. A shortcut is installed once per product, per workstation.

You may want to transfer a license to a computer temporarily (if you want to use an Autodesk product on your laptop, for example) or permanently (if the computer where you originally activated your Autodesk product is being replaced). You can leave the license on the secondary computer indefinitely, or you can move the license between computers as needed.

License transfers rely on the product’s serial number. Before an Autodesk product can be exported, it must be activated with the serial number and product key. During license import, a previously activated and exported license is imported to a product or product suite installed with the same serial number. The activation is transferred to the import computer, completing the license transfer.
NOTE The number of concurrent exports you can have, is equal to the number of seats you own. For example, if you own one seat you can have one export in progress at a time. You cannot complete another export until the one in progress has been imported. Similarly, if you have five seats, you can have up to five concurrent exports in progress at one time.

NOTE When you upgrade your Autodesk product (non-subscription), you can no longer perform online license transfers of the previous license.

NOTE Although the License Transfer Utility allows you to transfer your product license between computers, your license agreement may not allow the installation of an Autodesk product on more than one computer. Read your license agreement to find out whether your product license permits the use of the License Transfer Utility.

To transfer a license you must have an Internet connection, have an Autodesk product installed on both computers, and perform an online export and import of the license.

Install the Autodesk Product

Before you can use the License Transfer Utility to transfer licenses, you must have an Autodesk product installed on all computers involved in the transfer.

To install the Autodesk product

1. Install and activate the Autodesk product on a computer.
   See your product’s installation instructions for complete details.

2. Install the Autodesk product on any other computer that will be using the License Transfer Utility. You do not have to register or activate the product on this computer.
   See your product’s installation instructions for complete details.

Export a License

A license is exported when the License Transfer Utility moves a product license from a computer to the online Autodesk server.

The license can be exported as public or private. Exporting a license as public means that you are not reserving the license and anyone using the same serial
number and their own user ID and password can import that license. Exporting a license as private means that you are reserving that license for yourself and the license can only be imported with the same serial number, your user ID, and your password.

NOTE An Internet connection is required to export a license.

To export a license
1 On the computer where you want to export the license, do the following:
   ■ (Windows XP/Windows 7/Windows Vista) Click Start ➤ All Programs ➤ Autodesk ➤ [Autodesk Product] ➤ License Transfer Utility.
   The Export the License dialog box displays the Autodesk product name and serial number.
2 In the Export the License dialog box, click Sign In.
3 On the Log In page, enter your Autodesk user ID and password and click Log In.
4 On the License Export page, confirm the export information.
5 If you want to make the license available as a public import, click Make the license available as a public import.
6 Click Export.
7 On the License Export Confirmation page, click Finish.

Import a License
A license is imported when the License Transfer Utility moves a previously exported product license from the online Autodesk server to a computer.

When you have exported a product license from a computer, you complete the license transfer process by importing that license onto a computer. A license is imported when the License Transfer Utility creates an active license on a computer, allowing your Autodesk product to run on this computer.

When you use the License Transfer Utility to import a license to a computer, you are not activating the product on the computer; you are simply transferring your activation to this machine.

NOTE An Internet connection is required to import a license.
To import a license

1 On the computer where you want to import the license, do the following:
   ■ (Windows XP/Windows 7/Windows Vista) Click Start ➤ All Programs ➤ Autodesk ➤ [Autodesk Product] ➤ License Transfer Utility.

   The Import the License dialog box displays the Autodesk product name and serial number.

2 In the Import the License dialog box, click Sign In.

3 On the Log In page, enter your Autodesk user ID and password and click Log In.

4 On the License Import Confirmation page, click Finish.

   The license is now imported to the computer and you can run your Autodesk product on this computer. If you want to transfer the license to another computer, repeat the export and import procedures.

To import a license to replace a trial license

1 On the computer where you want to import the license, do the following:
   ■ (Windows XP/Windows 7/Windows Vista) Click Start ➤ All Programs ➤ Autodesk ➤ [Autodesk Product] ➤ License Transfer Utility.

   The Update the Serial Number and Product Key dialog box displays the Autodesk product name and serial number.

2 In the Update the Serial Number and Product Key dialog box, enter the serial number and product key to update your Autodesk product. Click Update.

   The Import the License dialog box displays the Autodesk product name and updated serial number.

3 In the Import the License dialog box, click Sign In.

4 On the Log In page, enter your Autodesk user ID and password and click Log In.

5 On the License Import Confirmation page, click Finish.

   The license is now imported to the computer and you can run your Autodesk product on this computer. If you want to transfer the license to another computer, repeat the export and import procedures.
Troubleshoot a Stand-Alone License Error

When you activate your Autodesk product, only the computer that you used to activate the product is licensed to run the product. If you make certain changes to your computer, your stand-alone license might fail. You will receive a license error and you will not be able to use your product. This section discusses ways in which you can troubleshoot a license error.

Some license errors require you to reactivate your product. If you need to reactivate your product, the Product Activation wizard is displayed when you try to run the product. To reactivate your product, follow the instructions in the Product Activation wizard.

The following topics offer more details regarding specific errors.

Hardware Changes

If you replace or reconfigure hardware on the computer where your Autodesk product license resides, the stand-alone license might fail. You will not be able to use your product.

To prevent damage to your product license, use the License Transfer Utility to export your license file. After you make the hardware change, you can import the license file back. For instructions about using the License Transfer Utility, see Transfer Your Stand-Alone License on page 5.

NOTE If you get a license error when you change your hardware, you may have to reactivate your license. See Activate Your Product on page 2.

Reinstalling an Operating System

If you reinstall your operating system on the computer where your Autodesk license resides, the license might fail. You will not be able to use your product.

To resolve a license error in this case, you must reactivate your product. See Activate Your Product on page 2.

To prevent a license error when you reinstall an operating system

NOTE If using Norton Ghost™ or another image utility, do not include the Master Boot Record.
1 Locate one of the following folders and make a backup copy:
   ■ (Windows XP) C:\Documents And Settings\All Users\Application Data\FLEXnet
   ■ (Windows 7/Windows Vista) C:\ProgramData\FLEXnet

2 Reinstall the operating system and reinstall the Autodesk product.

3 Paste the license folder to the same location from which you originally copied the folder in step 1.
   You can now run your Autodesk product.

Changing the System Date and Time

Your product license allows for time changes to the system clock within two days of the current time. If you set your system clock back more than two days, the next time you start your product, you will receive a message that gives you the option of correcting the system clock. If you do not correct the system clock, you receive a license error.

To prevent a license error due to a change in system date and time
   ■ Make sure that your computer’s system date and time are accurate when you install and activate your Autodesk product.

Distributing Software Image to Multiple Computers

You can use the Deployment Wizard’s Stand-alone option to create a software installation image on your server. You can distribute this image by making it available on your computer network. During creation of this image, you are prompted for registration information, which is stored with the image and deployed to all installations.

Additionally, you can manually distribute the software using the installation CD that comes with your Autodesk product. However, if your computers do not have an Internet connection, make sure the registration data for each computer matches exactly. Inconsistent registration data can cause activation failures.
To prevent a license error when distributing software image to multiple computers

- The distribution of applications using “ghosting” is not recommended, and can result in incomplete installations and activation problems.

Preserving Licenses on Re-Imaged Computers

On a network license server, licenses are maintained on the server. No additional steps are needed to preserve network licenses.

For stand-alone licenses, you need to export the licenses to a safe place before re-imaging the computers. You can use the License Transfer Utility to export the licenses. After the re-imaging, import the licenses to the correct computer. Each license only works on the computer for which it was created.
A network license allows you to run an Autodesk product on a network. Network licenses can be purchased through your Authorized Autodesk Reseller.

Setting up network licenses for an Autodesk product requires careful planning and execution. This section gives you instructions about how to set up a network licensed environment, and assumes that you are familiar with the terminology and processes required to set up an Autodesk product to run on a network.

**Plan Your Network Licensing**

This section contains information that you need to know before you set up a network license server. The section includes information about supported license server models, license operation and availability, network license file definitions and parameters, license file examples, license types and behaviors, and the license server heartbeat signal.

**System Requirements for the Network License Manager**

Make sure that your network license server meets the minimum recommended requirements. See the following tables for hardware and software requirements.

*NOTE* The Network License Manager supports Ethernet network configurations only.

<table>
<thead>
<tr>
<th>Hardware/Software</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating System</td>
<td>Windows® 7® 32-bit</td>
</tr>
<tr>
<td></td>
<td>Windows 7 64-bit</td>
</tr>
</tbody>
</table>
## Hardware and software requirements for the network license server

<table>
<thead>
<tr>
<th>Hardware/Software</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Windows 7 Starter (32-bit)</td>
</tr>
<tr>
<td></td>
<td>Windows 7 Home Basic (32-bit)</td>
</tr>
<tr>
<td></td>
<td>Windows 7 Home Premium</td>
</tr>
<tr>
<td></td>
<td>Windows 7 Professional</td>
</tr>
<tr>
<td></td>
<td>Windows 7 Ultimate</td>
</tr>
<tr>
<td></td>
<td>Windows 7 Enterprise</td>
</tr>
<tr>
<td></td>
<td>Windows Vista 32-bit SP2 or later</td>
</tr>
<tr>
<td></td>
<td>Windows Vista 64-bit SP2 or later</td>
</tr>
<tr>
<td></td>
<td>Windows Vista Enterprise</td>
</tr>
<tr>
<td></td>
<td>Windows Vista Business</td>
</tr>
<tr>
<td></td>
<td>Windows Vista Ultimate</td>
</tr>
<tr>
<td></td>
<td>Windows Vista Home Premium and Basic (32-bit)</td>
</tr>
<tr>
<td></td>
<td>Windows Vista Home Premium (64-bit)</td>
</tr>
<tr>
<td></td>
<td>Windows XP 32-bit SP2 or later</td>
</tr>
<tr>
<td></td>
<td>Windows XP 64-bit SP2 or later</td>
</tr>
<tr>
<td></td>
<td>Windows XP Home</td>
</tr>
<tr>
<td></td>
<td>Windows XP Professional</td>
</tr>
<tr>
<td></td>
<td>Windows Server 32-bit SP1 or later</td>
</tr>
<tr>
<td></td>
<td>Windows Server 64-bit SP1 or later</td>
</tr>
<tr>
<td></td>
<td>Windows 2008 Server R2</td>
</tr>
<tr>
<td></td>
<td>Windows 2008 Server</td>
</tr>
<tr>
<td></td>
<td>Windows 2003 Server R2</td>
</tr>
<tr>
<td></td>
<td>Windows 2003 Server</td>
</tr>
</tbody>
</table>

**Computer/processor**

- Intel® Pentium® III or higher
- 450 Mhz (minimum)

**Network interface card**

- Compatible with existing Ethernet network infrastructure
## Hardware and software requirements for the network license server

<table>
<thead>
<tr>
<th>Hardware/Software</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>NOTE</td>
<td>The Network License Manager supports multiple network interface cards, but at least one must be an Ethernet card.</td>
</tr>
<tr>
<td>Communication protocol</td>
<td>TCP/IP</td>
</tr>
<tr>
<td>NOTE</td>
<td>The Network License Manager uses TCP packet types.</td>
</tr>
<tr>
<td>Browsers</td>
<td>Internet Explorer® 6</td>
</tr>
<tr>
<td></td>
<td>Internet Explorer 7</td>
</tr>
<tr>
<td></td>
<td>Internet Explorer 8</td>
</tr>
<tr>
<td>FLEXnet</td>
<td>11.7.0.0</td>
</tr>
</tbody>
</table>

### Virtual Machine Support (Windows)

<table>
<thead>
<tr>
<th>Hardware</th>
<th>Virtualizer</th>
<th>Virtual OS</th>
</tr>
</thead>
</table>

## Plan Your License Server Configuration

You must decide which license server model to use for managing your Autodesk product licenses on a server. Autodesk supports the following network license server models:

- Single license server model
- Distributed license server model
- Redundant license server model
Single License Server Model

In the single license server model, the Network License Manager is installed on a single server, so license management and activity is restricted to this server. A single license file represents the total number of licenses available on the server.

Advantages of the Single License Server Model

- Because all license management takes place on a single server, you have just one point of administration and one point of failure.
- Of the three license server models, this configuration requires the least amount of maintenance.

Disadvantage of the Single License Server Model

- If the single license server fails, the Autodesk product cannot run until the server is back online.

Distributed License Server Model

In the distributed license server model, licenses are distributed across more than one server. A unique license file is required for each server. To create a distributed license server, you must run the Network License Manager on each server that is part of the distributed server pool.

Advantages of the Distributed License Server Model

- Servers can be distributed across a wide area network (WAN); they do not need to exist on the same subnet.
- If one server in the distributed server pool fails, the licenses on the remaining servers are still available.
- If you need to replace a server in the distributed server pool, you do not need to rebuild the entire pool.
- Server replacement is easier than in a redundant server pool, where you must reactivate the entire pool.

Disadvantage of the Distributed License Server Model

- If a server in the distributed server pool fails, the licenses on that server are unavailable.
Redundant License Server Model

In the redundant license server model, you use three servers to authenticate a single license file. One server acts as the master, while the other two provide backup if the master server fails. With this configuration, licenses continue to be monitored and issued as long as at least two servers are still functional. The license file on all three servers is the same. You must install the Network License Manager on each server.

In the redundant license server model, all servers must reside on the same subnet and have consistent network communications. (Slow, erratic, or dial-up connections are not supported.)

**Advantage of the Redundant License Server Model**

- If one of the three servers fails, all licenses that are managed in the server pool are still available.

**Disadvantages of the Redundant License Server Model**

- If more than one server fails, no licenses are available.
- All three servers must reside on the same subnet and have reliable network communications. The redundant server pool does not provide network fault tolerance.
- If one of the three servers is replaced, the complete redundant server pool must be rebuilt.
- If your Autodesk product supports license borrowing and licenses are borrowed from a redundant license server pool, you must restart the license server after you stop the Network License Manager.

Learn About Your License

In this section, you learn about license operation and availability, the license file, license types and behaviors, and the heartbeat signal.

License Operation and Availability

When you start an Autodesk product, the product determines the server from which it should try to obtain a license. The product then requests a license through the TCP/IP network protocol to the license server.
If the number of available licenses has not been exceeded on the license server, the Network License Manager assigns a license to the workstation. A product session then starts on the workstation, and the number of available licenses on the license server is reduced by one.

Likewise, when you exit a product, the Network License Manager frees a license for another user. If you run multiple sessions of an Autodesk product on an individual workstation, only one license is used. When the last session is closed, the license is freed.

The following three processes manage the distribution and availability of licenses:

- **License manager daemon** (*lmgrd.exe*). Handles the original contact with the application, and then passes the connection to the vendor daemon. The *lmgrd.exe* daemon is used to communicate with the vendor daemon only; *lmgrd.exe* does not authenticate or dispense licenses, but rather passes user requests to the vendor daemon. By using this approach, a single *lmgrd.exe* daemon can be used by multiple software vendors to provide license authentication. The *lmgrd.exe* daemon starts and restarts the vendor daemons as needed.

- **Autodesk vendor daemon** (*adskflex.exe*). Tracks the licenses that are checked out and the workstations that are using them. Each software vendor has a unique vendor daemon to manage vendor-specific licensing. As its name implies, the *adskflex.exe* vendor daemon is specific to Autodesk products.

**NOTE** If the *adskflex.exe* vendor daemon terminates for any reason, all users lose their licenses until *lmgrd.exe* restarts the vendor daemon or the problem causing the termination is resolved.

- **License file**. A text file that has vendor-specific license information.

**License Files**

The network license file you receive from Autodesk contains licensing information required for a network installation. You obtain license file data when you register your Autodesk product.

The license file contains information about network server nodes and vendor daemons. It also contains an encrypted digital signature that is created when Autodesk generates the file.
The license file is located in a network location that you specify in the Deployment wizard. That network location must be accessible to every user who runs the product from a network installation.

The following table defines each license file parameter.

<table>
<thead>
<tr>
<th>Definitions of license file parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Line</strong></td>
</tr>
<tr>
<td>SERVER</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>USE_SERVER</td>
</tr>
<tr>
<td>VENDOR</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>PACKAGE</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>COMPONENTS</td>
</tr>
<tr>
<td>OPTIONS</td>
</tr>
<tr>
<td>SUPERSEDE</td>
</tr>
</tbody>
</table>
## Definitions of license file parameters

<table>
<thead>
<tr>
<th>Line</th>
<th>Parameter</th>
<th>Definition</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIGN</td>
<td>Encrypted signature used to authenticate the attributes of the license file</td>
<td>SIGN=0 SIGN2=0</td>
<td></td>
</tr>
<tr>
<td>INCREMENT</td>
<td>Feature Code</td>
<td>Product supported by the license file</td>
<td>51200ACD_2007_0F</td>
</tr>
<tr>
<td>Expiration Date</td>
<td>Amount of time the licenses are available</td>
<td>permanent</td>
<td></td>
</tr>
<tr>
<td>Number of Licenses</td>
<td>Number of licenses supported by the license file</td>
<td>25</td>
<td></td>
</tr>
<tr>
<td>VENDOR_STRING</td>
<td>License usage type and license behavior of the product that is supported by the license file</td>
<td>COMMERCIAL</td>
<td></td>
</tr>
<tr>
<td>BORROW</td>
<td>Definition of the license borrowing period for the licenses defined under the same increment line. In this example, the maximum period that licenses can be borrowed is 4320 hours (180 days), unless otherwise noted (for example, BORROW=2880 means that licenses can be borrowed for a maximum of 2880 hours, or 120 days). License borrowing is disabled when this parameter is absent in the license file.</td>
<td>BORROW=4320</td>
<td></td>
</tr>
<tr>
<td>DUP_GROUP</td>
<td>Definition of multiple license requests when the same user and same host share the same license</td>
<td>DUP_GROUP=UH</td>
<td></td>
</tr>
<tr>
<td>ISSUED</td>
<td>Date that the license file was generated by Autodesk</td>
<td>15-jul-2006</td>
<td></td>
</tr>
<tr>
<td>Serial Number</td>
<td>Serial number of the Autodesk product</td>
<td>123-12345678</td>
<td></td>
</tr>
</tbody>
</table>
License File Examples

License file examples are provided in this document to help you understand how the license files work for your particular network setup. Autodesk provides a standard license file for individual products and a license file with additional parameters for products that are sold both individually and as part of a product set.

- **Standard License File.** If you purchase one or more individual products that are not offered as part of a suite of products, you receive a standard license file.

- **Standard License File with Additional Parameters.** If you purchase Autodesk products that are included in a product set and are also sold as an individual product, you receive a standard license file with additional parameters included in the license file. The additional parameters define the sequence for license usage so that the individual product license is used before the license for the product set.

Autodesk license file examples include a license file not specific to a product, completed license files for single, distributed, and redundant server models, a combined product version license file, and an example of additional parameters added to a standard license file.
Example of a License File Not Specific to a Product

Here is an example of the contents of a license file and the parameters associated with each line:

SERVER ServerName HostID
USE_SERVER
VENDOR adskflex port=portnumber
INCREMENT feature_code Adskflex Version ExpDate NumberOfLicenses
\nVENDOR_STRING=UsageType:Behavior BORROW=4320 SUPERSEDE \nDUP_GROUP=DupGrp ISSUED=IssueDate SN=SerialNumber SIGN= \n
Example of a License File for a Single or Distributed Server

Here is an example of a completed license file for a single or distributed license server model:

SERVER XXHP0528 0019bbd68993
USE_SERVER
VENDOR adskflex port=2080
INCREMENT 57600ACD_2009_0F adskflex 1.000 permanent 5 \nVENDOR_STRING=commercial:permanent BORROW=4320 SUPERSEDE \nDUP_GROUP=UH ISSUED=09-Jan-2008 SN=123-12345678 SIGN="1393 \nE368 816E D417 C1CD 7DBD 7B90 1354 D6F0 48FE EBB8 9C84 C3AF \n7D79 BEE1 0181 0655 76FF 996C B707 14B5 D4DE A3FE 0B2D 2D36 \n057C A579 7866 26BF 44E2" SIGN2="1280 943B 53A7 9B93 E00B D967 \nD821 BD37 BE6D B78A F074 B223 88AA 242C DD0A 1292 D56F 4108 \n62CD FA35 E365 0736 A011 7833 8B35 7BF DAD8 34A8 452F 2EB4"
Example of a License File for a Redundant Server

Here is an example of a completed license file for a redundant license server model:

```plaintext
SERVER CCN12378042 001cc4874b03 27005
SERVER XXHP0528 0019bbd68993 27005
SERVER CCN12378043 001cc4874b10 27005
USE_SERVER
VENDOR adskflex port=2080
INCREMENT 57600ACD_2009_0F adskflex 1.000 permanent 5 \ 
  VENDOR_STRING=commercial:permanent BORROW=4320 SUPERSEDE \ 
  DUP_GROUP=UH ISSUED=10-Jan-2008 SN=123-12345678 SIGN="11C4 \ 
  C79 07FC 7AD0 409A 6E04 6E98 D76C 197C 0416 076C B211 1CDD \ 
  D0AB 698B 16BF 7A0E D4F8 1CFE 2985 644F 64CD CECE 0DDB 5951 \ 
  3262 7C31 13A8 F08F 55B2" SIGN2="1A6 FDA3 2ED5 5301 8675 7B81 \ 
  1B0E 451B 19F1 1A99 C8E9 CBA6 8CB3 6AC3 8B38 1519 13F2 2373 \ 
  82AE 55E5 1A25 4952 4458 F3A2 6F28 D25D 1DC0 E066 209B 0953"
```

**NOTE** The redundant server model requires the addition of a port number (the default is 27005) for each server.

Example of a License File for Combined Autodesk Product Versions

You can combine a license file for different releases of the same Autodesk product or for different Autodesk products, and run all products from one license server. For example, you can combine a license file for AutoCAD 2009 with license files for Autodesk Maya® 2009 and AutoCAD Map.
Here is an example of the contents of a combined license file for AutoCAD 2008 and AutoCAD 2009:

```
SERVER XXHP0528 0019bbd68993
USE_SERVER
VENDOR adskflex port=2080
INCREMENT 57600ACD_2009_0F adskflex 1.000 permanent 5
  VENDOR_STRING=commercial:permanent BORROW=4320 SUPERSEDE \\n  DUP_GROUP=UH ISSUED=09-Jan-2008 SN=123-12345678 SIGN="1393 \n  E368 816E D417 C1CD 7DBD 7B90 1354 D6F0 48FE EBB8 9C84 C3AF \n  7D79 BEE1 0181 0655 76FF 996C B707 14B5 D4DE A3FE 0B2D 2D36 \n  057C A579 7866 26BF 44E2" SIGN2="1280 943B 53A7 9B93 E00B D967 \\n  D821 BD37 BE6D B78A F074 B223 88AA 242C DDA0 1292 D56F 4108 
  62CD FA35 E365 0736 A011 7833 8B35 7BFF DAD8 34A8 452F 2EB4"
INCREMENT 54600ACD_2008_0F adskflex 1.000 permanent 3
  VENDOR_STRING=commercial:permanent BORROW=4320 SUPERSEDE \\n  DUP_GROUP=UH ISSUED=09-Jan-2008 SN=123-12345678 SIGN="1E6E \n  4B61 5712 476E 92A0 67B2 9EF4 3F47 56A1 1F38 6DE8 C0C7 90AC \n  7289 152E 0E2A CC0D 3F10 577A 0489 CEB6 10D5 FBCC B552 0C9D \n  5966 91A6 59F0 2788 FACE" SIGN2="1DDF 3B9D 3392 71D5 AB0B 7E05 \\n  8497 111E 092F 0E54 8DC2 2BEC 17C2 2CC1 981B 0EC2 BC15 8F00 
  C79A ABFD 2136 BABA 2EDF E941 EA53 32C6 597F F805 5A8A 599A"
```

Example of Additional Parameters in a License File

For Autodesk products that are included in a product set and are also sold as an individual product, licenses are allocated based on a sequence of priorities
defined in the license file. For those products, information similar to the following example appears in a license file:

```
SERVER Server1 1a34567c90d2
USE_SERVER
VENDOR adskflex port=2080
INCREMENT 54600ACD_2008_0F adskflex 1.000 permanent 5 \ 
  VENDOR_STRING=commercial:permanent BORROW=4320 SUPERSEDE \ 
  DUP_GROUP-UH ISSUED=09-Jan-2007 SN=123-12345678 SIGN="0247 \ 
  45D6 87C4 27A5 7F9E F24A ED3D 61E4 6B3B CC5C AD77 B065 9EA8 \ 
  3D62 0792 0F67 19E7 57E7 FAFA A48B D582 335A EC16 1FE5 B70D \ 
  76AB 6488 61CC DE5E F5B7" SIGN2="09FD 0850 7CF1 F447 9F05 9FA3 \ 
  2A0A 38D6 83FC 1746 F3F5 5A72 6250 E002 DE0B 06E6 F88C AC95 \ 
  136F 87F2 A945 E4C4 A97F 44B5 74EE 83F3 3F3E 1579 B981 8994"
```

### Package License File Examples

Autodesk offers a package license file option, which allows you use of a set of products that are packaged and sold together. The package license file contains a set number of licenses for four different versions of your software. Running an instance of any one of the versions uses one license in the package. Packaged license files support prior versioning for subscription users. Package license files operate under the following guidelines:

- **Package license files come with the current version of the software and three previous versions of the same product.**
- **License files may be combined with license files for different products.** For more information about combining license files, see [Example of a Package License File for Combined Autodesk Product Versions](#) on page 28.
- **Package license files cannot be combined with non-package license files for product versions contained in the package.** For example, you cannot combine a *Autodesk Product* 2011 package license file with a regular license file for *Autodesk Product* 2010, 2009, or 2008.
- **Both the PACKAGE and INCREMENT sections of the license are required for licensing to work properly.** When you combine license files, be sure to include both of these sections.
- **License borrowing, option files, and licensing cascading work the same for package licenses as they do for regular license files.**
- **A new license file will supersede an older license file.**
The following sections provide package license file examples for single, distributed, and redundant license servers, and combined Autodesk product versions.

Example of a Package License File for a Single or Distributed Server

Here is an example of a completed license file for a single or distributed license server model:

```plaintext
SERVER Server1 1a34567c90d2
USE_SERVER
VENDOR adskflex port=2080
PACKAGE SERIES_1 adskflex 1.000 COMPONENTS="54700REVIT_2009_0F \ 54600ACD_2009_0F 51300INVBN_11_0F" OPTIONS=SUITE SUPERSEDE \ ISSUED=09-Jan-2008 SIGN="1707 9EAC CBCB 2405 692E 4A89 \ AA26 30CC 2AC2 D6B3 A61B AB5E 492E 3EBD 0B48 4E75 193A DA82" \ FC45 C009 E360 944A 14BA E99C 9B24 5A1B 4A44 083A BE5F 3827 \ SIGN2="004A FC90 AB47 3F6B 59BC 0E6D 6681 6971 A76A BA52 98E2 \ 5671 26B3 0E78 791B 109F 0591 7DC3 F09F 4D8D 4FB7 E341 4A03 \ CD68 1D77 27F8 8555 9CF7 DEDD 9380"
INCREMENT SERIES_1 adskflex 1.000 permanent 100 \ VENDOR_STRING=commercial:permanent BORROW=4320 DUP_GROUP=UH \ SUITE_DUP_GROUP=UHV SN=123-12345678 SIGN="1707 9EAC CBCB \ 692E 4A89 FC45 C009 E360 944A 14BA E99C 9B24 5A1B 4A44 BE5F \ 3827 AA26 30CC 2AC2 D6B3 A61B AB5E 492E 3EBD 0B48 DA82" \ SIGN2="004A FC90 AB47 3F6B 59BC 0E6D 6681 6971 A76A BA52 \ 5671 26B3 0E78 791B 109F 0591 7DC3 F09F 4D8D 4FB7 E341 4A03 \ CD68 1D77 27F8 8555 9CF7 DEDD 9380"
```

26 | Chapter 2  Network Licensing
Example of a Package License File for a Redundant Server

Here is an example of a completed license file for a redundant license server model:

```plaintext
SERVER 1a34567c90d2 27005
SERVER 2a34567c90d2 27005
SERVER 3a34567c90d2 27005
USE_SERVER
VENDOR adskflex port=2080
PACKAGE 64300ACD_F adskflex 1.000 COMPONENTS="57600ACD_2009_0F \ 54600ACD_2008_0F 51200ACD_2007_0F 48800ACD_2006_0F" \\ OPTIONS=SUITE SUPERSEDE ISSUED=27-May-2008 SIGN="1092 05D8 \ A206 276B 2C84 EFAD ACA5 C54B 68A4 653E C61F 31DE C8CE B532 \ CFBB 0006 5388 347B FDD6 A3F4 B361 7FD4 CDE4 4AAC 0D11 B0EF \ 4B44 BFD6 3426 97DD" SIGN2="0670 B01A D060 0069 FF25 F1CD D06B \\ 314E E7C9 3552 5FFA 4AC7 28A7 C897 F56A 19BB FB1C 754E 6704 \ DEEA AC4E F859 2E9B 64B6 0DD0 9CCE 9556 269F EAC0 2326"
INCREMENT 64300ACD_F adskflex 1.000 permanent 50 \ VENDOR_STRING=commercial:permanent BORROW=4320 SUPERSEDE \ DUP_GROUP=UH SUITE_DUP_GROUP=UHV ISSUED=27-May-2008 \ SN=399-99999999 SIGN="1B5B 8D70 4CAD 32E5 9CA2 82E0 5C47 291C \ 35A9 9B9C 5B3E 5067 F61B 4139 1B32 0716 1FD3 5105 A991 B78E \ 9D1E 63AB BC23 0D1E B70C 2A05 E1C1 F605 ABB1 2EA8" SIGN2="01D6 \ 31F5 2951 4500 E5C8 058F 7490 9789 9EF4 CBED DA27 5F06 6780 \ 9033 2018 0C3B E1ED 3580 E60E C2BB B4AB 8D6A 4245 3059 8CA6 \ 2EFE DFAE 027F 2ABE 3F2B"
```

Learn About Your License | 27
Example of a Package License File for Combined Autodesk Product Versions

Here is an example of a completed license file for combined Autodesk product versions:
SERVER servername 123456789111
USE_SERVER
VENDOR adskflex port=2080
PACKAGE 64300ACD_F adskflex 1.000 COMPONENTS="57600ACD_2009_0F \ 54600ACD_2008_0F 51200ACD_2007_0F 48800ACD_2006_0F" 
OPTIONS=SUITE SUPERSEDE ISSUED=25-Jun-2008 SIGN="03EF DE18 \ 8046 0124 4EA4 6953 F82D 3169 7C24 D0E8 E58E 8168 FFA3 D891 \ B43B 08D8 7E7F C6ED CBC7 FE2A BBOA 4566 C2AE F1C1 D373 8348 \ E6E3 884A E398 1C78" SIGN2="07AC D696 8844 D19F AB00 8B75 53A3 \ 2F76 91DF AED0 3231 1506 0E6B ADC6 C3B8 1797 93B5 9756 8C0F \ 8811 56E6 B280 0523 FE26 82B7 1628 076F 1738 F37C 7240"
INCREMENT 64300ACD_F adskflex 1.000 permanent 2 \ VENDOR_STRING=commercial:permanent BORROW=4320 SUPERSEDE DUP_GROUP=UHV SUITE_DUP_GROUP=UHV ISSUED=25-Jun-2008
SN=399-99999999 SIGN="1CCB E88D B819 8604 06FA 9AEE 42F1 CB5A \ 37B9 3CFA A0A8 697F 9CB1 8354 6256 05ED 69D4 D2FF D512 6A2E \ D50D B722 EF5B 3172 BA95 4625 F8D3 DD24 B839 6A58" SIGN2="0DFF \ FA6F C378 20E0 2622 BE52 B434 F9F9 2681 2B93 64F2 CE6C 7F4A \ 7024 B3D1 051A 6920 72BD DE35 8920 E6A1 C8D6 AF23 7BB7 CC91 \ 6916 70B1 9E80 AB07 1644"
PACKAGE 64800INVPRO_F adskflex 1.000 \ COMPONENTS="59600INVPRO_2009_0F \ 55300INVPRO_2008_0F 51400INVPRO_2007_0F 49000INVPRO_2006_0F" 
OPTIONS=SUITE SUPERSEDE ISSUED=25-Jun-2008 SIGN="130E 5990 \ F8A1 56FB 10D8 9DA7 D6AE 8E9E F6EC 2B62 36D7 36E2 C5F8 E6E1 \ A4AA 0128 8CDA 95FD 09B2 ABA1 6F9B A0A3 70DE 3220 6835 7E51 \ 3849 D818 8BDC 9DC1" SIGN2="0021 AA08 F2E7 8AEB 5345 341F 7E42 \ 3001 B8C5 DFC2 6EB8 87C5 C04A AE43 A10F 1DA1 EF8A F0FA 10F5 \ AC81 1E22 789F A18D 650F 6BBB 563A BDA5 DDC1 82EC 27F6"
INCREMENT 64800INVPRO_F adskflex 1.000 permanent 2 \ VENDOR_STRING=commercial:permanent BORROW=4320 SUPERSEDE DUP_GROUP=UHV SUITE_DUP_GROUP=UHV ISSUED=25-Jun-2008
SN=399-99999966 SIGN="0BE4 51F4 570C DC48 5E66 F952 629E EDFO \ 019C 6FF7 0509 1FF0 D4FB 3B16 1981 073F 31EC A241 8CBB 8782 \ E655 00C6 E097 D5EF BOD8 67D3 199D 699D 2E09 B16F" SIGN2="1254 \ 3E37 0CE4 F42D B7CD 858C 92FC A963 527A 770F 9354 FE29 E117 \ 205D C632 0C4E AEC0 7501 9D9E FFE8 D84D F154 16A1 E120 339A"
License Types and Behaviors

Autodesk supports dynamic product usage and license behaviors. This means that you can purchase a specific type of behavior with a specific license and change that license at a later date without having to uninstall and reinstall the Autodesk product.

**NOTE** All license types are available as stand-alone and network except for the Student Portfolio license, which is available as stand-alone only.

License types include the following:

- **Commercial.** A license for a product that was purchased commercially.
- **Not for Resale.** A license for a product that is not sold commercially. Not for Resale products are for evaluation or demonstration purposes only and may not be used for commercial or production use.
- **Educational (EDU)/Institution.** A license designed specifically for educational institutions.
- **Student Portfolio.** A license for students who are using an Autodesk product as part of their curriculum.

License behaviors are as follows:

- **Permanent.** Enables permanent use of an Autodesk product.
- **Term Extendable.** Enables access to an Autodesk product for a limited time. The term can be extended at any time.
- **Term Non-Extendable.** Enables an Autodesk product for a limited time. The term cannot be extended.

Heartbeat Signal

When an Autodesk product is running, it communicates with the license server at regular intervals using a communication method known as the “heartbeat” signal. If the heartbeat signal is lost, the server tries to reconnect. If the server cannot reconnect, the user receives a license error.
If the product stops working because it has lost a connection to the server, you must shut down the product, and then restart it. If the problem causing the original loss of the heartbeat signal is resolved and there are available licenses on the server, the program can be restarted.

**Network License Manager**

The Network License Manager is used to configure and manage the license servers. When creating a deployment, the Installation wizard prompts you for information about the license manager, such as license server model and server name.

For more information about deploying an Autodesk product from a network location, see your product’s installation documentation.

**Install the Network License Manager**

You can install the Network License Manager before or after you use the Installation wizard. The order in which you install the network applications does not matter, as long as you install everything you need and you provide consistent license server information across the network applications.

If an earlier version of the Network License Manager is already installed on the computer, you should upgrade by installing the Autodesk Network License Manager into the folder where the older version was located.

**To install your Network License Manager**

1. In the Autodesk Installation wizard, click Install Tools and Utilities.

2. On the Select the Products to Install page, select Autodesk Network License Manager and click Next.

3. Review the Autodesk software license agreement for your country or region. You must accept this agreement to proceed with the installation. Choose your country or region, click I Accept, and then click Next.

   **NOTE** If you do not agree to the terms of the license and want to terminate the installation, click Cancel.

4. On the Begin Installation page, review your product selection and the current settings. If you do not want to change anything, click Install. If you want to change the install type or installation path, click Configure.
5  On the Select the Installation Location page, accept the default installation path (C:\Program Files\Autodesk Network License Manager) or Browse to specify a different path. If you enter a path that does not exist, a new folder is created using the name and location you provide. Click Next.

**WARNING** Do not install the Network License Manager on a remote drive. When you install the Network License Manager files, you must provide a path to a local drive. You must specify the drive letter; the universal naming convention (UNC) is not permitted.

6  On the Configuration Complete page, click Configuration Complete to return to the confirmation page.

7  On the Begin Installation page, click Install.

8  When the Installation Complete page displays, click Finish.

**Obtain a License Through autodesk.com**

You can register and activate your network license by going to https://registeronce.autodesk.com and following the on-screen instructions.

**Obtain the Server Host Name and Host ID Manually**

Autodesk uses the server host name, host ID, and product serial number to generate a license file.

To obtain the information manually, you can use the command prompt or you can run the *lmtools.exe* utility. If you use *lmtools.exe*, do not run it on a remote workstation.

**To obtain the host name and ID using the Windows command prompt**

1  Do the following:
   - (Windows XP/Windows Vista) Click Start ➤ All Programs ➤ Autodesk ➤ [Autodesk Product] ➤ License Transfer Utility.

2  At the Windows command prompt, enter the following command, and then press ENTER:
   - `ipconfig /all`

3  Locate the Host Name line, and write down the host name.
Locate the Physical Address line. Write down the physical address without the dashes. This is your twelve-character host ID.

NOTE If your server has more than one network adapter, select the one that corresponds to a physical network adapter. To determine which adapters are physical: in the Windows command prompt, enter `ipconfig /all`, and then view the Description field above each physical address. If there is more than one physical network adapter, it does not matter which one you use. Devices such as VPN adapters, PPP adapters, and modems are not valid.

Close the Windows command prompt.

To obtain the host name and ID using lmtools.exe

You should be logged in with Administrator rights when working with the LMTOOLS utility.

1. Click Start ➤ All Programs ➤ Autodesk ➤ Network License Manager ➤ LMTOOLS Utility.
2. In the LMTOOLS program, click the Systems Settings tab.
3. On the Systems Settings tab, locate the Computer/Hostname box. Copy the host name and paste the information into a text editor.
4. Locate the Ethernet Address box. The Ethernet address is the host ID. It consists of twelve characters. Write down the information. If your Ethernet address is more than twelve characters, write down the first twelve characters only.

NOTE If your server has more than one Ethernet adapter, select one that corresponds to a physical network adapter.

5. Close lmtools.exe.

Configure a License Server

You configure a license server so that you can manage your Autodesk product licenses. Configure the license server with the lmtools.exe utility.
To configure your license server

You should be logged in with Administrator rights when working with the LMTOOLS utility.

1. Click Start ➤ All Programs ➤ Autodesk ➤ Network License Manager ➤ LMTOOLS Utility.

2. In the LMTOOLS program, on the Service/License File tab, make sure the Configure Using Services option is active.

3. Click the Config Services tab.

4. In the Service Name list, select the service name you want to use to manage licenses.
   By default, the service name is *Flexlm Service 1*. If FLEXnet® is managing other software on your computer in addition to Autodesk, you can change the service name to avoid confusion. For example, you can rename *Flexlm Service 1* to *Autodesk Server1*.

   **NOTE** If you have more than one software vendor using FLEXnet for license management, the Service Name list contains more than one option. Make sure that only one Autodesk service is listed.

5. In the Path to Lmgrd.exe File field, enter the path to the Network License Manager daemon (*lmgrd.exe*), or click Browse to locate the file.
   By default, this daemon is installed in the *C:/Program Files/Autodesk Network License Manager* folder.

6. In the Path to the License File box, enter the path to your license file, or click Browse to locate the file.
   This is the path to the license file obtained through autodesk.com or the location where you placed the license file if you obtained it offline.

7. In the Path to the Debug Log File box, enter a path to create a debug log, or click Browse to locate an existing log file.
   It is recommended that you save to the *C:/Program Files/Autodesk Network License Manager* folder. The log file must have a *.log* file extension. For new log files, you must enter the *.log* extension manually.

8. To run *lmgrd.exe* as a service, select Use Services.

9. To start *lmgrd.exe* automatically when the system starts, select Start Server at Power Up.
10 Click Save Service to save the new configuration under the service name you selected in step 4. Click Yes when prompted if you would like to save the settings to the service.

11 Click the Start/Stop/Reread tab and do one of the following:
   ■ If a service has not yet been defined for Autodesk, click Start Server to start the license server.
   ■ If a service for Autodesk is already defined and running, click ReRead License File to refresh the Network License Manager with any changes made to the license file or Options file.

The license server starts running and is ready to respond to client requests.

12 Close lmtools.exe.

NOTE Before performing any system maintenance on your license server, see Stop and Restart the License Server on page 37.

Install SAMreport-Lite (Optional)

SAMreport-Lite is a reporting tool that helps you track network license usage. With SAMreport-Lite technology from Acresso™ Software, you can monitor client usage for Autodesk network licensed products.

To learn more about installing and using SAMreport-Lite, see the SAMreport-Lite User’s Guide.

Uninstall the Network License Manager

You can uninstall the Network License Manager from the license server. When you uninstall the Network License Manager, licenses are no longer available to your users.

To uninstall the Network License Manager

1 Click Start ➤ All Programs ➤ Autodesk ➤ Network License Manager ➤ LMTOOLS Utility.

2 In the LMTOOLS program, click the Start/Stop/Reread tab.

3 On the Start/Stop/Reread tab, click Stop Server.
4 Close intools.exe.

5 In the Windows Control Panel, do one of the following:
   ■ (Windows XP) Double-click Add/Remove Programs.
   ■ (Windows 7/Windows Vista) Double-click Programs and Features.

   Do one of the following:
   ■ (Windows XP) In the Add/Remove Programs window, click Autodesk
     Network License Manager. Click Remove.
   ■ (Windows 7/Windows Vista) In the Programs and Features window,
     click Autodesk Network License Manager. Click Remove.

6 If prompted, restart your computer.

NOTE You must manually delete files that you created for use with the Network License Manager (such as log files, license files, and the Options file). They are not automatically deleted when you uninstall the Network License Manager.

Network Licensing Tools

Autodesk Network licensing tools include FLEXnet configuration tools, license borrowing, and SAMreport-Lite. Each tool is described in the sections that follow.

This section also includes information for updating FLEXnet and installing and configuring the Autodesk Network License Manager on a network.

FLEXnet Configuration Tools

The Network License Manager uses FLEXnet® license management technology from Acresso Software. FLEXnet provides administrative tools that help to simplify management of network licenses. You can use FLEXnet tools to monitor network license status, reset licenses lost to a system failure, troubleshoot license servers, and update existing license files on the fly.

Utilities for License Server Management

FLEXnet provides two utilities for managing the license server. These tools are located in the C:\Program Files\Autodesk Network License Manager folder.
**lmtools.exe** Provides a Microsoft® Windows graphical user interface for managing the license server.

**lmutil.exe** Provides a set of command line options for managing the license server.

You can use *lmtools.exe* or *lmutil.exe* to perform the following server management tasks:

- Start, stop, and restart the server.
- Configure, update, and reread the license file.
- Diagnose system or license problems.
- View server status, including active license status.

---

**Stop and Restart the License Server**

Before you can perform any system maintenance on your license server, you must stop the license server. When you have completed maintenance, you can restart the license server.

**To stop the license server**

You should be logged in with Administrator rights when working with the LMTOOLS utility.

1. Click Start ➤ All Programs ➤ Autodesk ➤ Network License Manager ➤ LMTOOLS Utility.
2. In the LMTOOLS program, on the Service/License File tab, select the Configure Using Services option.
3. Select the service name for the license server you want to stop manually.
4. Click the Start/Stop/Reread tab.
5. On the Start/Stop/Reread tab, click Stop Server.
6. Close *lmtools.exe*.

**To restart the license server**

You should be logged in with Administrator rights when working with the LMTOOLS utility.
1  Click Start ➤ All Programs ➤ Autodesk ➤ Network License Manager ➤ LMTOOLS Utility.

2  In the LMTOOLS program, on the Service/License File tab, select the Configure Using Services option.

3  Select the service name for the license server you want to start manually.

4  Click the Start/Stop/Reread tab.

5  On the Start/Stop/Reread tab, click Start Server to restart the license server.

---

**Update FLEXnet from a Previous Version**

This release of Autodesk products and later require FLEXnet version 11.7.0.0 or later. If you are currently using a version of FLEXnet that is earlier than 11.7.0.0, you need to upgrade to version 11.7.0.0 or later.

---

**NOTE** If the server where you plan to install the Autodesk Network License Manager has FLEXnet installed for another product, make sure that the version of lmgrd.exe is the most current version.

To determine what version of FLEXnet is installed, you need to verify the version of the following files:

**Windows**

- lmgrd.exe
- ltools.exe
- lmutil.exe
- adskflex.exe

To verify the version of lmutil.exe, ltools.exe, or adskflex.exe (Windows)

You should be logged in with Administrator rights when working with the LMTOOLS utility.

1  Click Start ➤ All Programs ➤ Autodesk ➤ Network License Manager ➤ LMTOOLS Utility.

2  In ltools.exe, click the Utilities tab.
On the Utilities tab, enter the location of the file, or click the Browse button to locate the file and click Open. The file location should look something like this:

*C:\Program Files\Autodesk Network License Manager\lmutil.exe*

On the Utilities tab, click Find Version. The version number of the file you selected is displayed. If necessary, use the following procedure to update your version of FLEXnet.

**To update FLEXnet**

You should be logged in with Administrator rights when working with the LMTOOLS utility.

1. Back up your license files.

2. Click Start ➤ All Programs ➤ Autodesk ➤ Network License Manager ➤ LMTOOLS Utility.

3. In the LMTOOLS program, click the Start/Stop/Reread tab.


5. Close *lmtools.exe*.

6. Note the location where the Network License Manager is installed and then uninstall the Network License Manager. For details about uninstalling the Network License Manager, see *Uninstall the Network License Manager* on page 35.

7. Install the Network License Manager. For details about installing the Network License Manager to the same location as the previous version, see *Install the Network License Manager* on page 31.

8. Do one of the following:
   - (Windows XP) Click Start ➤ Programs ➤ Autodesk ➤ Network License Manager ➤ LMTOOLS.
   - (Windows Vista /Windows 7) Double-click the LMTOOLS icon on the desktop.

9. In the LMTOOLS program, click the Start/Stop/Reread tab.


11. Close *lmtools.exe*. 
Set Up and Use an Options File

With an Options file, you set configuration options for managing licenses on each license server that you set up. An Options file sets parameters that the license file reads and the `lmgrd` program executes.

If you want to have the same license behavior on some or all of your license servers, you must save the same Options file to each of those license servers. If you want to specify different license behavior on different license servers, you must create an Options file for each license behavior. You must save each Options file to the server where you want specific license behavior.

**NOTE** For Options file changes to take effect on a license server, you must save the Options file, and then use `lmtools.exe` to reread the license file.

Use the Options file to set parameters for the following server-related features:

**Report log file** A compressed, encrypted file is created that generates accurate usage reports on license activity for use by SAMreport-Lite. See Create a Report Log on page 41.

**License borrowing** If your Autodesk product supports the license borrowing feature, you can allow users to borrow an Autodesk product license from a network license server so that they can use the product without being connected to the license server. A license can be borrowed for a limited time. See Configure License Borrowing with the Options File on page 42.

**License timeout** With license timeout, you can set a timeout period on your license server for one Autodesk product at a time. When set, license timeout returns a license to the license server when a connection with the workstation is lost, or if a license is checked out but the Autodesk product is idle on a workstation for longer than the timeout period you define. See Set Up License Timeout on page 43.

**License timeoutall** With license timeoutall, you can set a timeout period on your license server that applies to all Autodesk products installed on your computer. When set, license timeout returns a license to the license server when a connection with the workstation is lost, or if a license is checked out but the Autodesk product is idle on a workstation for longer than the timeout period you define. See Set Up License Timeout on page 43.

Here is an example of the contents of an Options file:

```
REPORTLOG=c:\test\report.rl

BORROW_LOWATER Autodesk_f1 3
```
You can also set up advanced license parameters, such as reserving a license, restricting license usage, or defining groups of users. To learn more about setting advanced Options file parameters, see the FLEXnet documentation in the C:\Program Files\Autodesk Network License Manager\LicenseAdministration.pdf file.

Create an Options file

You should be logged in with Administrator rights when working with the LMTOOLS utility.

To create an options file

1. Open a text editor, enter the parameters you want, and then save the document as a file named adskflex.opt to the same location where you saved the license file.

   **NOTE** Make sure you save the file with the extension .opt. The default extension .txt is not recognized by the Network License Manager.

2. Do one of the following:
   - (Windows) Click Start ➤ All Programs ➤ Autodesk ➤ Network License Manager ➤ LMTOOLS Utility.

3. In the LMTOOLS program, on the Start/Stop/Reread tab.
4. On the Start/Stop/Reread tab, click ReRead License File.
5. Close lmtools.exe.

Create a Report Log

In the Options file, you can create a report log file that is used with SAMreport-Lite.

To create a report log

1. In a text editor, open the Options file, adskflex.opt.
2. In the Options file, enter the following syntax on its own line (with REPORTLOG entered in uppercase, as shown):
REPORTLOG [+report_log_path
For example (Windows), the syntax REPORTLOG +c:\My
Documents\report.rl means that a report log named report.rl is located
in the folder c:\My Documents.

NOTE Path names that contain spaces must be enclosed in quotation marks.

In the REPORTLOG syntax, “[+]” means that entries to the log file you
create are appended rather than replaced each time the Network License
Manager is restarted. (It is recommended that you use this option so that
you retain a history of log entries.)

Configure License Borrowing with the Options File

If your Autodesk product supports the license borrowing feature, you can use
the Options file to configure license borrowing options. For example, you can
define the maximum number of licenses that can be borrowed from your
network at any one time. In addition, you can define which users can borrow
an Autodesk product license. Licenses are borrowed per user, not per machine.

NOTE If your Autodesk product supports license borrowing, and licenses are
borrowed from a redundant license server pool, you must restart the license server
after you stop the Network License Manager.

At the end of a borrow period, the borrowed license is automatically disabled
on the user's computer and becomes available again on the license server.
Users can also return a license before a borrow period has ended.

To set license borrowing parameters

1 In the Options file, enter the following syntax on its own line (with
BORROW_LOWATER entered in uppercase, as shown):

BORROW_LOWATER feature_code n

In the BORROW syntax, “feature_code” is the name of the product in
the license file, and “n” is the number of licenses that cannot be borrowed.

For example, the syntax BORROW_LOWATER Autodesk_f1 3 means
that for the product Autodesk_f1, three licenses cannot be borrowed from
the license server.

2 Enter the following syntax on the next line (with MAX_BORROW_HOURS
entered in uppercase, as shown):
**MAX_BORROW_HOURS feature_code n**

In this syntax, “n” is the number of hours that a license can be borrowed. For example, the syntax MAX_BORROW_HOURS Autodesk_f1 360 means that for product Autodesk_f1, licenses can be borrowed for 360 hours, or 15 days.

**NOTE** Licenses are borrowed in increments of 24 hours only. Any number that is more than a 24-hour increment is not used. For example, the number 365 would be rounded down to 360 hours, or 15 days.

For more information about setting up the license borrowing feature, see the FLEXnet documentation in the `C:\Program Files\Autodesk Network License Manager` folder.

**NOTE** To borrow a license in an Autodesk product, click Help menu ➤ About ➤ Product Information. Alternatively, enter `borrowlicense` on the product command line. Help for this feature is available in the Borrow a License for [Autodesk Product] window and in `C:\Program Files\[Autodesk Product]\Help\adsk_brw.chm`.

---

**Set Up License Timeout**

License timeout is set in the Options file to determine how long a product session can be idle before the license is reclaimed by the license server. When you set this flag in the Options file, a user’s license is reclaimed by the license server if the product is idle on a workstation for more than the timeout period you define.

If a user’s license is lost because of the idle timeout, the product attempts to claim a new license once the user uses the product again. If no license is available, the user can save work before the product shuts down.

You can set individual license timeouts for each Autodesk product on your computer by using the TIMEOUT parameter or you can set one license timeout for all Autodesk products on your computer by using the TIMEOUTALL parameter.

**To set license timeout parameters**

- For individual Autodesk products: In the Options file, enter the following syntax on its own line (with TIMEOUT entered in uppercase, as shown):

  TIMEOUT feature_code n
In the TIMEOUT syntax, “feature_code” is the name of the product (referred to in the INCREMENT line in the license file), and “n” is the number of seconds before an inactive license is reclaimed by the license server.

For example, the syntax TIMEOUT Autodesk_f1 7200 means that for the product Autodesk_f1, the license timeout period is set for 7200 seconds, or two hours.

For all Autodesk products: In the Options file, enter the following syntax on its own line (with TIMEOUTALL entered in uppercase, as shown):

```
TIMEOUTALL n
```

In the TIMEOUTALL syntax, “n” is the number of seconds before an inactive license is reclaimed by the license server.

For example, the syntax TIMEOUTALL 7200 means that for all Autodesk products, the license timeout period is set for 7200 seconds, or two hours.

For more information about using the license timeout feature, see the FLEXnet documentation in the `C:\Program Files\Autodesk Network License Manager` folder.

### License Borrowing

If you are running a network-licensed version of the program, you can borrow a license from a license server to use the program for a specified time when your computer is not connected to the network.

**NOTE** If you have a stand-alone version of the program, you cannot borrow a license. To check your license type, click Help menu ➤ About ➤ Product Information. In the Product Information dialog box, view your product license type.

### Overview

If you are using a network-licensed version of your Autodesk product and your network administrator supports the license borrowing feature, you can borrow a product license from your network license server to use the program when your computer is not connected to the network. Your license is automatically returned to the license server at the end of the day on the return date you set when you borrowed the license. You can also return a license early.
NOTE There is a limit to the number of licenses available for borrowing. If you try to borrow a license and are notified that no licenses are available, all network licenses may already be borrowed by other users. If you are unable to borrow a license, see your network administrator for help.

Borrow a License

You can run the program when your computer is not connected to the network until your license-borrowing period ends. If you don't remember the date that a license expires, you can check the date by placing your cursor over the Borrowing icon in the program's status tray or by clicking Help ➤ About and using the Product Information dialog box.

When the license-borrowing period expires, the borrowed license is automatically returned to the license server. Once your computer is reconnected to the network, you can run the program from the network or borrow a license again.

Interaction with Other License-Borrowing Tools

Using the license borrowing feature in the program is the recommended way to borrow a license; however, some third-party borrowing tools may also be available to you. These tools are not supported or compatible with the license borrowing feature in the program. Other third-party or legacy license-borrowing tools that may be available to you are the Autodesk License Borrowing utility (shipped with Autodesk products) and the borrowing feature in lmtools.exe, a component of the Autodesk Network License Manager.

If another license-borrowing tool is active when you attempt to use the license borrowing feature, you should proceed as follows to borrow a license for the program:

- If you run the Autodesk License Borrowing utility that shipped with your Autodesk product and then turn on the borrowing flag for the Adskflex option or the All option, a license can be borrowed when you start the program. However, you cannot return a license until you exit and then restart the program.

- If borrowing is set in lmtools.exe for all products, you can either (a) use the other tool to borrow licenses for the program or (b) stop the borrowing process in lmtools.exe and then use the license borrowing feature in the program.
If borrowing is set in `lntools.exe` for non-Autodesk products only, you must stop the borrowing process in `lntools.exe`. You can then use the license borrowing feature to borrow licenses for your Autodesk product. If you do not stop the borrowing process in `lntools.exe`, the license borrowing feature will not function.

**To borrow a license using the Tools menu**

1. Click Tools menu ➤ License Borrowing ➤ Borrow License.
2. In the Borrow a License window, on the calendar, click the date when you want to return the license.
   This date must be within the valid date range set by your network administrator. The valid date range is displayed in this window.
3. Click Borrow License.
4. In the License Borrowed message, click OK. The license is borrowed, and you can now use the program while your computer is disconnected from the network.

**NOTE** You can verify that your license is borrowed by placing your cursor over the Borrowing icon in the status tray, which is in the lower-right corner of the program.

**To borrow a license using the Help menu**

1. Click Help menu ➤ About.
2. In the About product window, click Product Information.
3. In the Product Information window, click Borrow License.
4. In the Borrow a License window, on the calendar, click the date when you want to return the license.
   This date must be within the valid date range set by your network administrator. The valid date range is displayed in this window.
5. Click Borrow License.
6. In the License Borrowed message, click OK. The license is borrowed, and you can now use the program while your computer is disconnected from the network.
BORROWLICENSE Command

Borrows a product license so that you can run the product outside the network environment.

Tools menu: License Borrowing ➤ Borrow License
Help menu: About ➤ Product Information ➤ Borrow License
Command line: borrowlicense
The Borrow a License Window on page 47 is displayed.

Borrow a License Window

Tools menu: License Borrowing ➤ Borrow License
Help menu: About ➤ Product Information ➤ Borrow License
Command line: borrowlicense
Using the license borrowing feature, you can borrow a license from your network license server, and then use the license when your computer is disconnected from the license server; for example, when you are traveling for work.

The Borrow a License window has the following options:

Calendar Sets the date when you plan to return a borrowed license. The return date must be within the range specified by your network administrator.

Borrow a License Borrows the license from the network license server based on the return date that you specified.

Cancel Cancels the borrowing action; no license is borrowed.

Return a License

Your network license is automatically returned to the network license server on the day that the license expires. You can also return a license earlier than the date you originally selected, as long as your computer is connected to the network license server when you attempt to return the borrowed license.

Once a borrowed license is returned, you can borrow a license again as long as your computer is connected to the network license server and a license is available on the server.
To return a borrowed license early, do one of the following:

- Click Tools menu ➤ License Borrowing ➤ Return License Early.
- Click Help menu ➤ About ➤ Product Information. In the Product Information dialog box, click Return License, and then click Yes.
- In the status tray, right-click the License Borrowing icon. Click Return License Early.

**NOTE** To use the status tray to return a borrowed license early, the display settings for the status tray must be turned on. To turn on the display settings, right-click an empty area on the status bar. Click Tray Settings.

Your license is returned to the network license server. After you return the borrowed license, you can borrow a license again immediately as long as a license for that product is available on the network.

To check the license return date, do one of the following:

- In the status tray, right-click the License Borrowing icon. View the expiration date for the borrowed license.
- Click Help menu ➤ About ➤ Product Information. In the Product Information dialog box, under License Expiration Date, view the license return date.

**RETURNLICENSE Command**

Returns a borrowed Autodesk product license earlier than the original return date that you specified when you borrowed the license.

Tools menu: License Borrowing ➤ Return License

Help menu: About ➤ Product Information ➤ Return License

Status tray: Right-click the License Borrowing icon. Click Return License Early.

Command line: `returnlicense`

**Network Licensing FAQs**

This section outlines some common questions and their solutions with regards to software licenses and licensing your product(s).
What is the difference between a stand-alone license and a network license?

Stand-alone licensed products are registered and activated to an individual workstation. While the software can be installed on multiple systems in your facility, the license only allows one system to be operational. If you need to run more systems simultaneously, you need to purchase more stand-alone licensed products, or consider converting to network licenses.

Network licensed products rely on the Network License Manager to keep track of software licenses. The software can be installed and run on multiple systems simultaneously, up to the maximum number of licenses you’ve purchased. The Network License Manager “checks out” licenses until they are all in use. No further systems can run the program until a license is “checked in.” If you need to run more systems simultaneously, you can purchase additional licenses for the Network License Manager to maintain.

Stand-alone licensed products are registered and activated to an individual workstation. While the software can be installed on multiple systems in your facility, the license only allows one system to be operational. If you need to run more systems simultaneously, you need to purchase more stand-alone licensed products. Alternatively, you could purchase multi-seat stand-alone licenses if you intend to deploy to a large amount of stand-alone licensed systems.

You cannot purchase a network licensed version of an Autodesk product that does not rely upon the use of the Network License Manager software. However, a multi-seat stand-alone licensed version is available that does not rely on servers to maintain licenses. Multi-seat stand-alone licensing allows the same serial number to be used for the registration and activation of the product on multiple systems. This means that if a multi-seat stand-alone version of the software is deployed to multiple systems, the serial number only needs to be entered once.

What is the benefit of using a network licensed version of the software?

Network licensed products are recommended for large drafting/design facilities, classrooms, and lab environments. The main advantage is that you can install products simultaneously on more systems than the number of licenses you have purchased (for example, purchasing 25 licenses but installing on 40 workstations). At any one time, products will run on the maximum number
of systems for which you have licenses. This means you get a true floating license. If software needs to be run on more systems, additional licenses can be purchased.

Registration and activation occurs only once and the licenses are maintained on your Network License Server.

Unlike a network licensed product, you can install multi-seat stand-alone products on the maximum number of systems that the license allows. For example, you purchase a multi-seat stand-alone license for 25 seats and have 30 systems at your facility that can communicate over the Internet. Even though you can install software on all 30 systems, only the first 25 systems you start will have their licenses activated. The licenses are tied to each specific system. Therefore, the remaining five systems will never be able to run the software unless you purchase an additional five licenses.

As long as all the systems have Internet access, products are automatically activated the first time they are launched.

What is Internet Explorer used for?

After installing your product, you can operate in trial mode for a given number of days. Whenever you launch the program, you are prompted to activate the software. When you choose to activate the software, Internet Explorer makes this process much faster. Once you entered your registration data and submit it to Autodesk, an activation code is returned and you are not prompted again during startup.
Glossary

*adskflex.exe* The Autodesk vendor daemon used with the FLEXnet license technology. This daemon keeps track of the Autodesk licenses that are checked out and the workstations that are using the licenses.

*ADSKFLEX_LICENSE_FILE* In a distributed license server configuration, the environment variable used to point a workstation to the distributed license servers.

*borrowed license* A license that allows you to use an Autodesk product for a limited period of time without having to buy a separate license or have network access to the license server.

*daemon* A program that runs continuously in the background of a computer. The daemon handles requests from the computer and then forwards the requests to other programs or processes. The Network License Manager uses two daemons: the vendor daemon (*adskflex.exe*) and the license manager daemon (*lmgrd.exe*).

*debug log file* A file used with FLEXnet to log connection activity (such as license failure or starting and stopping) between the Network License Manager and the workstation.

*deployment* The files and folders created on a server and used by workstations to install Autodesk programs.

*distributed server* A license server configuration option in which several servers are used to manage license distribution. Each distributed license server has a unique license file and a fixed number of licenses. If one distributed license server fails, the other servers are still able to distribute their licenses.

*Ethernet address* See *host ID*.

*feature code* A license file parameter that represents the product that is supported by that license file.

*FLEXnet* The Acresso Software license management technology implemented in the Autodesk family of products.
heartbeat signal  The communication signal between the Network License Manager and the workstation to verify that the workstation is accessible and has an active Autodesk product session running.

host ID  The unique hardware address of a network adapter. Also known as Ethernet address or physical address.

host name  The TCP/IP name associated with a computer. FLEXnet technology uses the host name as a parameter; the host name must be distinguished from the NetBIOS (server) name.

idle  A state of inactivity in your product that prompts a network license server to reclaim a license. Inactivity is due to no mouse or keyboard activity and no commands, MAXScript scripts, menu macros, rendering, or other activity in progress for the period of time that is defined in the Options file. See also license timeout.

JRE (Java Runtime Environment)  A program that is required to run Java programs. This program must be installed with SAMreport-Lite.

license file  A file used with FLEXnet that controls the number of available seats. This file must be in ASCII plain text format.

license server  A server that contains the Network License Manager.

license timeout  A feature that allows you to set up a timeout period on your license server to automatically return an idle license to the server so that it is available for use again.

licpath.lic  In both single and redundant server configurations, the file used to point the workstation to the FLEXnet license server. Licpath.lic is located in the root installation folder.

lmgrd.exe  The license manager daemon. This daemon handles the original contact with the program, and then passes the connection to the vendor daemon, adskflex.exe.

lmtools.exe  A graphical user interface utility used to administer the FLEXnet license technology. (lmutil.exe is the command line version of this utility.)

lmutil.exe  A command line utility used to administer the FLEXnet license technology. (lmtools.exe is the graphical user interface version of this utility.)

master daemon  See lmgrd.exe.

network license installation  A type of installation that requires you to install and run the Network License Manager from a network server. You must install
and configure the Network License Manager before clients can run the Autodesk product.

**Network License Manager** The technology used by Autodesk for network license management.

**Options file** The file used by FLEXnet to control license manager parameters, such as reserving licenses and creating report logs used with SAMreport-Lite.

**physical address** See *host ID*.

**redundant server** A license server configuration option in which three servers are used to administer licenses. The redundant servers share a license file and a pool of licenses. The redundant server pool remains functional as long as two of the three servers are running and communicating with each other.

**report log file** A file used with FLEXnet and SAMreport-Lite. This log file provides information about network license usage. The Options file creates the report log.

**SAMreport-Lite** A version of Acresso Software’s SAMreport tool. SAMreport-SAMreportLite is included on the Autodesk product discs.

**vendor daemon** See *adskflex.exe*.

**workstation** A desktop computer used by an individual user on a network.
Index

A
activating programs 2, 7
activation code 1
AdLM (Network License Manager) 31
Adskflex option 45
adskflex.exe (Autodesk vendor daemon) 18, 38
Autodesk License Borrowing utility 45
Autodesk License Manager 31
Autodesk Network License Manager 45
Autodesk products activating 2
borrowing network licenses for 44
License Transfer utility 5
reinstalling 9
using off network 44
Autodesk vendor daemon 38

B
borrowing licenses about 44
configuring 42
reconnecting and borrowing again 45, 47
returning licenses 47
borrowing periods 45
BROWNLICENSE command about 47

C
Commercial licenses 3, 30
computers licenses for 5
re-imaged 11
configuring license borrowing 42
license servers 33, 40
copying licenses 5, 9

D
daemons
license manager daemons 18
vendor daemons 18
versions of 38
dates expiration 45
system dates 10
Deployment wizard 10
displaying product license information 3
distributed license server model about 16
license file example 22
distributing software installation images 10

E
early returns of licenses 47
Educational (EDU)/Institution licenses 3, 30
Ethernet address 32
expiration dates for licenses about 45
exporting licenses about 5
transfer files 6

F
FLEXnet tools about 36
Options file 40–42
updating 38

55 | Index
G

glossary 53

H

hardware
  license errors and 9
hardware requirements
  Network License Manager 13
 heartbeat signals 30
 host IDs 32
 host names 32

I

importing licenses
  about 5
  transfer files 7
Imtools.exe 45
installation
  License Transfer utility 6
  Network License Manager 31
  SAMreport-Lite 35
Installation wizard 31

L

license borrowing
  about 44
  borrowing licenses 44–45
  configuring 42
  expiration dates 45
  returning licenses 47
  third-party licensing tools 45
license files
  about 18
  additional parameters in 24
  combined products 23
  examples 21
  package examples 25
license manager daemon 18, 38
license servers
  borrowing licenses 44–45
  configuring 33, 40
 heartbeat signals 30
 host IDs and host names 32
 limited number of licenses 45
 management utilities 36
 models 15
 Network License Manager 31
 returning licenses 47
 stopping and restarting 37
 third-party licensing tools 45
 types of 15
 license timeout 43
 License Transfer utility
  about 5
  installing 6
  transferring licenses 5
 licenses
  about 17
  active 5
  assigning 17
  availability 17
  behaviors (term limits) 30, 40
  copying 9
  exporting 6
  FLEXnet tools 36
 glossary 53
 importing 7
 issues 48
 license errors 9
 license files 18
 license servers 33
 license timeout 43
 moving between computers 9
 Network License Manager 31
 single-user 1
 transferring 5, 7
 troubleshooting 9
 types of 30
 limits on number of licenses 45
 lmgrd.exe (license manager daemon) 18, 38
 lmtools.exe utility 32–33, 36, 38
 lmutil.exe utility 36, 38
 log files
  report log files 41

56 | Index
M
Microsoft Windows
  configuring license servers 33
  Network License Manager 13

N
network license installations
  license behaviors 40
  license borrowing 42
  license timeout 43
  planning 13
  tools and utilities 36
  types of 30
  Network License Manager
    about 31
    assigning licenses 17
    glossary 53
    installing 31
    license server models 15
    uninstalling 35
  network license servers
    borrowing licenses 44–45
    limited number of licenses 45
    returning licenses 47
    third-party licensing tools 45
  Not for Resale licenses 3, 30

O
operating systems
  reinstalling 9
Options file (FLEXnet tools) 40–42

P
package license files 25–28
parameters in license files 24
periods for licenses
  about 45
Permanent licenses 3, 30
permanent transfers of licenses 5
physical address 32
private licenses 6
Product Activation wizard 1, 9
public licenses 6

R
re-imaged computers 11
reactivating programs 9
redundant license server model
  about 17
  license file example 23
  package license files 27
registering programs 2
reinstalling
  operating systems 9
report log files 41
return dates for licenses
  about 45
returning borrowed licenses 45, 47
RETURNLICENSE command 48

S
SAMreport-Lite
  installing 35
serial numbers
  updating 4
servers
  host IDs and host names 32
  license servers 31, 33
  stopping and restarting 37
single license server model
  about 16
  license file example 22
  package license files 26
single-user licenses 1
software requirements
  Network License Manager 13
stand-alone licenses 1
Student Portfolio licenses 3, 30
system dates 10
system requirements
  Network License Manager 13
system times 10
T
TCP/IP names 32
temporary transfers of licenses 5
Term Extendable licenses 3, 30
Term Non-Extendable licenses 3, 30
third-party licensing tools 45
time
    system time 10
time periods for licenses about 45
timeouts 43
transfer files
    exporting 6
    importing 7
transferring licenses 5
Trial licenses 3
troubleshooting license errors 9

U
uninstalling
    Network License Manager 35
updating
    FLEXnet tools 38
upgrading
    Network License Manager 31

V
vendor daemons 18, 38

W
Windows
    configuring license servers 33
    Network License Manager 13
Quick Start to
SAMreport-Lite

This section gives you step-by-step instructions for installing SAMreport-Lite on your system. If you have any questions that are not addressed in this Quick Start section, consult the appropriate sections in this User’s Guide.

How to Obtain a License File

Before you install SAMreport-Lite, you must obtain a license file. SAMreport-Lite runs on any computer, but it can read only the report logs from the license server(s) where you obtain a license file. You will be asked for the location of this file during installation.

To obtain a license file

1 On the server where you plan to manage licenses and report on them, click:
   (Windows XP) Click Start menu ➤ Programs ➤ Autodesk ➤ Network License Manager ➤ LMTOOLS Utility
   (Windows Vista) Click Start menu ➤ All Programs ➤ Autodesk ➤ Network License Manager ➤ LMTOOLS Utility

2 In LMTOOLS, click the System Settings tab.

3 Record the host ID, which is located in the Ethernet Address field.

   **NOTE** If your server has more than one Ethernet adapter, select one that corresponds to a physical network adapter.

4 Exit LMTOOLS.
5 Next, you need to request a license file from Acresso Software. On the Internet, go to the following website:
  http://autodesk.globes.com

6 Fill out your customer information on the Web Fulfillment for SAMreport-Lite page, and click Submit Online.

7 You will need a license file for each server in your environment. Select the license server model you are using - Single, Redundant, or Distributed.

8 Enter your license server HostID, and click Submit Online. The HostID is the ID you recorded in step 3.

9 After completing the online request for the license file, you will receive an email that contains the license information. Copy and paste the license information from the email into a text editor. Save the file with an extension of .lic or .dat. Make sure you note where you saved the file and what you named it. You will be prompted for the location of the license file during the SAMreport-Lite installation.

How to Install SAMreport-Lite

If you do not yet have a license, you need one before you can install SAMreport-Lite. See How to Obtain a License File on page 1.

To install SAMreport-Lite

1 In the Installation wizard, click Install Tools and Utilities.

2 On the Select the Products to Install page, select SAMreport-Lite and then click Next.

3 At the Begin Installation page, click Install.

4 On the Welcome to the InstallShield Wizard for SAMreport-Lite page, click Next.

5 Click Next if you want to install to the default directory, or click Browse to specify a different location.

6 Locate your saved license file (.lic or .dat). Copy and paste the file’s location into the License File Location box. Click Next.

7 Review your installation information in the Summary Information page, and click Next. The installation process starts. Use the Back button if you want to make changes.
How to Install Java Runtime Environment

**NOTE** Java Runtime Environment is automatically installed with SAMreport-Lite for some products. If it is not automatically installed for your product, follow the install instructions in this section.

SAMreport-Lite requires Java Runtime Environment 1.4.2_04.

**To install Java Runtime Environment**

1. Insert the Autodesk product media into your computer's drive.
2. Go to `<product>/x86/support/SAMreport-Lite/Java 2 Runtime Environment, SE v1.4.204` and click on the Windows Installer Package.
3. On the License Agreement page, accept the terms, and then click Next.
4. On the Setup Type page, select Typical or Custom and click Next. The installation will begin.
   A Typical installation installs all of Java's features. With a Custom installation, you can specify the install directory and choose program features to install. Custom installs are only recommended for advanced users.
5. When the installation process is complete, click Finish.

How to Create and Set Up an Options File

To use SAMreport-Lite, you must configure your license server(s) to generate report logs. In the Network License Manager, you set up an Options file to enable SAMreport-Lite to create report logs.

**NOTE** Complete instructions for setting up an Options file are located in the *Autodesk Licensing* guide. You can access the guide from your product's menu browser or in the Help system.

**To create and set up an Options file**

1. In a text editor, create a file called `adskflex.opt`.
2 In the *adskflex.opt* file, enter the following syntax on a single line:

   ```
   REPORTLOG [+ report_log_path
   ```

   REPORTLOG must be uppercase, as shown.

   In the REPORTLOG syntax, “[+]” means that entries to the log file you create are appended rather than replaced each time the Network License Manager is restarted. (It is recommended that you use this option so that you retain a history of log entries.)

   Path names that contain spaces must be enclosed in quotation marks. For example, the syntax REPORTLOG + “c:\My Documents\report.rl” means that a report log named *report.rl* is located in the folder *c:\My Documents*.

3 Save the *adskflex.opt* file to the same location where your license file exists.

4 Stop and then restart the Network License Manager.

---

**How to Use SAMreport-Lite**

**To use SAMreport-Lite to generate a report**

1 Click Start menu (Windows) ➤ All Programs (or Programs) ➤ SAMreport ➤ SAMreport.

2 In the SAMreport-Lite window, click the Browse button.

3 In the Report Log dialog box, locate and specify your report log file.

   By default, the Report Log dialog box lists only files named with a *.rl* file name extension. If your report log file has a different extension, such as *.log*, open the Files of Type list and select All Files to list all the files.

4 In the SAMreport-Lite window, in the Output File box, specify the folder location and file name for your report output files.

   You do not need to specify the file name extension; the extension is automatically added to the name you supply based on the output formats you select. For example, if you select HTML and Text output formats and specify *c:\my documents\report* in Output File, the following report files are generated:

   - *c:\my documents\report.html*
   - *c:\my documents\report.txt*
NOTE  Be sure to specify the full path name for your output files. If you don’t, output files are written to the current working directory, which may be the Windows desktop. Specifying a full path name ensures that your report files are saved in the folder you choose.

5 On the Report menu, click Generate. The report you specified is generated.

For more information about generating reports, see Basics of Generating a Report on page 9 and Usage Summary Report on page 13.
Introduction

This chapter contains introductory information about license management, a description of SAMreport-Lite, and explanatory information about this guide.

Intended Audience

SAMreport-Lite and this manual are intended for system administrators, system analysts, and managers who use FLEXnet® license management to produce usage reports for your software.

About This Manual

This manual is divided into five chapters and two appendixes:

- Quick Start to SAMreport-Lite on page 1 provides quick instructions for installing and using SAMreport-Lite. This chapter defines license management and introduces SAMreport-Lite.


- Usage Summary Report on page 13 describes the Usage Summary report, and describes how to arrange report output.

- Report Input and Output on page 17 shows how to specify input files and describes output formats.


- SAMreport-Lite Error Messages on page 29 lists some errors that you might get while running SAMreport-Lite.
What is License Management?

License management is a set of technologies that monitors the use of software. In some cases, it may also limit use of a product or record usage of a product.

Most software companies have legal agreements that detail the obligations of the manufacturer and user to each other. These agreements are often referred to as “licenses.” Some companies also include license management technology to simplify the legal use of their products. Throughout this documentation, the term “license” refers to a “token” obtained through some electronic technology, not the legal agreement between a customer and a software vendor.

License management is embedded into a software product by the software vendor.

What is SAMreport-Lite?

SAMreport-Lite, a member of the GLOBEtrrotter family of Software Asset Management (SAM) Solutions, is a report generator that helps you monitor the usage of applications that use FLEXnet. SAMreport-Lite complements FLEXnet by providing a graphical user interface (GUI) from which to run usage reports. SAMreport-Lite can help you make better decisions about your software assets.

SAMreport-Lite generates reports based on the license usage activity recorded in FLEXnet report logs. FLEXnet report logs are produced by vendor daemons and maintain a record of the activity of the vendor daemon. Enabling and Managing Report Logs on page 23 describes how to start and manage report log files.

The SAMreport-Lite report generator comes with a predefined report type, which allows you to quickly start generating reports. The report summarizes data from your report logs into categories.

SAMreport-Lite processes the data from one or more report log files and writes the results to a file and/or displays results on the screen. The Usage Summary report produces a textual output that summarizes the usage statistics of each feature. The output of this report can be saved to files in text, HTML, or Report Interchange Format (RIF). RIF can be used to export report data to another software program, such as a spreadsheet.
Basics of Generating a Report

This chapter shows you how to generate a Usage Summary report using the SAMreport-Lite user interface. You'll find a detailed explanation of the report in Usage Summary Report on page 13.

Generate a Usage Summary Report

Using SAMreport-Lite you can generate a network license-usage report, called Usage Summary, for Autodesk software that uses FLEXnet licensing technology.

To generate a Usage Summary report from the SAMreport-Lite interface

1. Start SAMreport-Lite.
2. Select Usage Summary from the Report Type list.
3. Specify one or more report log files.
4. Using one of the following two methods, specify the location of each of the report logs you want to run with SAMreport-Lite.
   - In the text field to the right of the Browse button, enter the path to the report log. Press ENTER. Repeat this process for each report log that you want to add.
   - Click the Browse button and use the report log file browser to select a report log from your system. Double-click the report log file. You can repeat this process to select more than one report log from the browser.

After you select a report log, the report log file name is displayed in the text box above the Remove button. To remove a report log from the list, click to highlight the report log, then click the Remove button.
There is no fixed limit on the size of a report log that you run through SAMreport-Lite, but the execution time of a report is proportional to the amount of report log data that is processed.

5 Specify an output format and/or an output file name base.

A Usage Summary report is displayed on the screen from a file. Therefore, if you want to display a Usage Summary report on the screen, you must specify an output file format and output file name base.

Unavailable output formats are grayed out. All reports written to files require an output file name base and at least one output format selection.

The file name base can be entered using one of two methods:

- In the text field to the right of the Output File button, enter the path and file name base. If no path is specified, the files are written to the current working directory.
- Click the Output File button to open a file selection browser. Find and double-click the directory in which you want to save the output file. Enter the file name base in the file selection browser. Click the Save button.

**NOTE** Do not enter a file extension (such as .txt). SAMreport-Lite adds the appropriate file extension based on the file type that you chose.

6 Specify how you want the report data summarized and arranged.

7 Specify the start and end dates for the report output.

Use these fields to limit the date range of data to include in a report. To include data from the entire report log(s) in your report, leave these fields blank. See Setting Start and End Dates for a Report on page 21.

8 Click Report ➤ Generate or click the Generate Report button.

A SAMreport-Lite Viewer window is displayed and the report progress indicator moves from 0-100% as the report runs. Status messages, including any errors that occurred during report processing, are written in the Status History pane. You should see a status message indicating whether a report was produced. Even if a report was generated, there may be warnings or errors that are displayed here.

If you want to stop generating a report, click the Stop button on the toolbar or click Report ➤ Stop.
After a report is generated, the SAMreport-Lite Viewer window contains one or more pages of the report output.
A Usage Summary report produces textual output that summarizes the usage statistics of each feature in the report log(s).

**Usage Summary Report Output**

The output of a Usage Summary report can be saved to files in HTML, text, or RIF format. The header of a Usage Summary report provides a summary of information about the report log and the parameters of the report:

<table>
<thead>
<tr>
<th>FLEXnet License Usage Report date time</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Produced by SAMreport-Lite</td>
<td>Version</td>
</tr>
<tr>
<td>Input Report Log:</td>
<td>List of input report log(s)</td>
</tr>
<tr>
<td>Output File Name:</td>
<td>Name of report output file</td>
</tr>
<tr>
<td>Report Log(s) Start:</td>
<td>Earliest start date in any report log</td>
</tr>
<tr>
<td>Report Log(s) End:</td>
<td>Latest end date in any report log</td>
</tr>
<tr>
<td>Report Start Date:</td>
<td>Date to begin report—either a filter start date or the starting date of the earliest report log</td>
</tr>
<tr>
<td>Report End Date:</td>
<td>Date to end the report—either a filter end date or the ending date of the latest report log</td>
</tr>
<tr>
<td>Uptime:</td>
<td>Duration in real clock time between the report start and end dates that a license server was up</td>
</tr>
</tbody>
</table>
A Usage Summary report with default settings contains one line per feature and 11 columns per line. From left to right in the report, the columns are:

<table>
<thead>
<tr>
<th>Time Period</th>
<th>Available</th>
<th>License Requests</th>
<th>Used</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>max</td>
<td>hours total used que den unscup tde max hours thr</td>
<td></td>
</tr>
</tbody>
</table>

Summary For: GLOBALclient
Total 50 4677 42 42 0 0 0 0 35 1269 27.1

Summary For: FLEXadmin
Total 70 1871 37 37 0 0 0 0 6 58.7 3.1

Summary For: FLEXexpress
Total 60 4677 257 257 0 0 0 0 31 911.5 19.5

<table>
<thead>
<tr>
<th>Category</th>
<th>Column Heading</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Available</td>
<td>max</td>
<td>Maximum number of available licenses. Includes overdraft licenses.</td>
</tr>
<tr>
<td>License Requests</td>
<td>total</td>
<td>Total number of license requests.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Category | Column Heading | Description
--- | --- | ---
 | used | Number of licenses requests fulfilled. |
 | que | Number of license requests queued. |
 | den | Number of license requests denied. |
 | unsup | Number of license requests not fulfilled because the feature is unsupported. |
 | %den | Percent of license requests that were denials. |
 | max | Maximum number of licenses used simultaneously. Includes overdraft licenses. |
 | hours | Number of available license hours used. |
 | %hrs | Percent of available license hours used. |

Possible explanations for denials in reports where the maximum available number of licenses were never used include:

- The number of available licenses changed during the report period.
For example, you start your report log when you have 10 licenses of FeatureA, then a few months later, still writing to the same report log, you add 10 more FeatureA licenses. Your report might show the max available licenses = 20, max used licenses = 18, and denials. Remember that the denials may have occurred when you only had 10 licenses available.

- Licenses are reserved for particular users.
  Even though all licenses for a feature are not checked out, they are not available to all users. If someone outside the reservation group tries to check out a reserved license, that user will be denied a license. License reservations are set in a vendor daemon’s options file.

- Users are excluded from the group of users who can check out a license.
  Even though all licenses for a feature are not checked out, a particular user may be excluded from using a license and gets a denial when trying to check out a license. Exclusions are set in a vendor daemon’s options file.

### Output Arrangement and Detail

The Usage Summary report shows license usage by feature. To create a report that shows more detail about the nature of license usage, you can use a combination of:

- Summary period
- Breakdown category
- Sort order specification
- Feature description

Using these controls, you can decompose the usage of each feature into useful groupings according to your particular reporting requirements.

You may use the Summary choice lists in the SAMreport-Lite main window, which provide easy access to the Feature, User Name, and User Host Name breakdown categories. You will notice that changing the breakdown settings automatically changes the sort order to defaults that correspond to your breakdown settings.

If you specify multiple breakdown categories, the resulting report shows use of features by each unique combination of breakdown categories.
You can create reports using one or more report logs from one or more FLEXnet vendor daemons, as long as each report log is written by a single vendor daemon running on a single host. (Each redundant vendor daemon must write to its own report log.)

### Specifying Input Report Logs

The only valid input files are FLEXnet report logs. These report logs may have been produced by redundant license servers or distributed license servers, or they may simply be archived report logs from one or more license servers. Report logs must be accessible to SAMreport-Lite. Enabling and Managing Report Logs on page 23 describes how to start and manage report log files.

You must specify at least one report log before running a report. You must specify the location of each of the report logs you want to run with SAMreport-Lite using one of the following two methods.

- In the text field to the right of the Browse button, enter the path to the report log. Press ENTER. Repeat this process for each report log that you want to add.

- Click the Browse button and use the report log file browser to select a report log from your system. Double-click the report log file. You can repeat this process to select more than one report log from the browser.

After you select a report log, the report log file name is displayed in the text box above the Remove button. To remove a report log from the list, click to highlight the report log, then click the Remove button.

There is no fixed limit on the size of a report log that you run through SAMreport-Lite, but the execution time of a report is proportional to the amount of report log data that is processed.
Displaying Output to the Viewer Window

All reports generated in the SAMreport-Lite interface are displayed on the screen in a SAMreport-Lite Viewer window, even if you specify one or more output files.

Navigating the SAMreport-Lite Viewer Window

The SAMreport-Lite Viewer window is divided into two sections. A list of the titles of individual pages of a report or a list of output formats is displayed in the left side of the SAMreport-Lite Viewer. A textual page of a report is displayed in the right side of the Viewer. If the displayed page is longer than the display space (often the case with textual report output), you can read the rest of the page by moving the scrollbar at the right margin of the Viewer. A navigation toolbar and report progress indicator are displayed at the top of the Viewer.

You can display different pages or output formats of a report in one of three ways:

■ Click the page name in the left side of the window.
■ Click the Back and Forward buttons in the toolbar.
■ Click Next or Previous on the Page menu.

Selecting Output Type and Output File Names

Different output formats are available; unavailable output formats are grayed out. All reports written to files require an output file name base and at least one output format selection.

The file name base can be entered in one of two methods:

■ In the text field to the right of the Output File button, enter the path and file name base. If no path is specified, the files are written to the current working directory.
■ Click the Output File button to open a file selection browser. Find and double-click the directory in which you want to save the output file. Enter the file name base in the file selection browser. Click the Save button.
The appropriate file name extension is automatically appended to a file name base, depending on the file's output format.

<table>
<thead>
<tr>
<th>Output Format</th>
<th>File Name Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>HTML</td>
<td>.html</td>
</tr>
<tr>
<td>Text</td>
<td>.txt</td>
</tr>
<tr>
<td>Report Interchange Format</td>
<td>.rif</td>
</tr>
</tbody>
</table>

See a description of RIF in Output Formats on page 19.

SAMReport-Lite does not warn you if the output file that you are defining already exists and that you are about to overwrite it.

Output Formats

Usage Summary reports are available in the following formats:

- **Text.** This format is suitable for printing and reading, but not for parsing.
- **HTML.** This format is suitable for posting textual reports to a web page.
- **Report Interchange Format (RIF).** This format is a simple, flexible, plain text format that is designed to pass tabular information between the report generator and another program, such as a spreadsheet. Fields are delimited by multiple spaces.

Textual reports are written to a single RIF file; each page of a multipage graphical report is written to a separate RIF file. Sequential numbers (starting with 0) are appended to the file name base of the RIF files and they have the extension .rif. A Table of Contents RIF file is generated for each RIF report and is named output_filename_base_toc.rif.

Format Specification

```
#BEGIN HEADER
header lines
#END HEADER
```
If you break down data by more than one category in a Usage Summary report written in RIF, each of the categories is presented in its own column. A RIF file can have more than one table. The #rows entry is not present if the file contains rows from only one table. If the #rows entry is missing, read all of the rows until the end of the file. If there is more than one table in the RIF file, the table-specific portion of the format is repeated for each additional table.

### Data Filters

Some of the information contained in the report log is subject to filtering. You can specify two filters for a Usage Summary report—user and feature.

Multiple filter categories for one report are applied with a Boolean AND operation—all the specified conditions must be satisfied. If a report is filtered on user (User1) and feature (Feature2), the resulting report contains usage of Feature2 by User1.

Multiple instances of a single filter category are applied with a Boolean OR operation. If a report is filtered on user==User1 and user==User2, the resulting report contains usage of features by either User1 or User2.

Multiple filter values for the same filter category can be specified on the same line separated by a space or on separate lines. For example, user==User1 User2 is equivalent to user==User1 and user==User2.
Reports and Time Zones

Timestamps in a report log are determined by the clock on the license server machine. The times are converted from the time zone of the license server machine and stored in the report log in Greenwich Mean Time (GMT), also known as Universal Time (UTC). Therefore, the data in a report log is insensitive to time zones, and you can run a report using report logs that were written on machines in different time zones without compensating for time differences. Reports, on the other hand, show time using the time zone set on the machine where the report was generated. SAMreport-Lite translates times in UTC from the report log using the offset for the time zone of the machine on which SAMreport-Lite is running.

For example, if you have an event in a report log that was written at 1pm by a vendor daemon running on a license server in the US Eastern time zone, its timestamp in the report log would be written as 6pm GMT. If an event in a report log was written at 10am by a vendor daemon running on a license server in the US Pacific time zone, its timestamp would also be written as 6pm GMT. If those two report logs were used to generate a report in the US Pacific time zone, those two events would both be reported at 10am. If the same report were generated on a computer in the US Eastern time zone, the events would both be reported at 1pm.

Possible causes for the times in reports that are different than you expect are:

- The time zone on the license server machine is set incorrectly. If the time zone is not set correctly, and the system clock has been set to show local time, an error is introduced into the UTC timestamps recorded in the report log.

- The time zone on the machine where SAMreport-Lite is running is set incorrectly. Even if the clock time looks correct, the time zone may not be set correctly.

Setting Start and End Dates for a Report

Start and end dates for report output can be set in text fields in the middle portion of the SAMreport-Lite main window. Times can be included. If no start and end dates are set, the report is generated with data from the entire report log. If no time is specified, days begin at midnight, 00:00:00.
The following formats are accepted for 3:30 pm on January 31, 2008:

<table>
<thead>
<tr>
<th>Format</th>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MM/dd/yyyy HH:mm:ss</td>
<td>1/31/2008 15:30:00</td>
<td>24-hour clock with seconds</td>
</tr>
<tr>
<td>MM/dd/yyyy HH:mm</td>
<td>1/31/2008 15:30</td>
<td>24-hour clock without seconds</td>
</tr>
<tr>
<td>MM/dd/yyyy</td>
<td>1/31/2008</td>
<td>Basic date</td>
</tr>
<tr>
<td>yyyyMMdd HHmmss</td>
<td>20080131 153000</td>
<td>4-digit year, 2-digit day, 2-digit month, 2-digit time, 2-digit seconds</td>
</tr>
<tr>
<td>yyyyMMdd HHmm</td>
<td>20080131 1530</td>
<td>4-digit year, 2-digit day, 2-digit month, 2-digit time, 2-digit seconds</td>
</tr>
<tr>
<td>yyyyMMdd</td>
<td>20080131</td>
<td>4-digit year, 2-digit day, 2-digit month</td>
</tr>
<tr>
<td>MMM dd, yyyy HH:mm:ss</td>
<td>Jan 31, 2008 15:30:00</td>
<td>3-letter month abbreviation, 2-digit day, 4-digit year, 2-digit time</td>
</tr>
<tr>
<td>MMM dd, yyyy HH:mm</td>
<td>Jan 31, 2008 15:30</td>
<td>3-letter month abbreviation, 2-digit day, 4-digit year, 2-digit time</td>
</tr>
<tr>
<td>MMM dd, yyyy</td>
<td>Jan 31, 2008</td>
<td>3-letter month abbreviation, 2-digit day, 4-digit year</td>
</tr>
</tbody>
</table>

HH is measured by a 24-hour clock (0-23). MMM can be either the three-letter abbreviation for the name of a month or the full name of the month (Jan, January, jan, january, JAN, JANUARY).
Enabling and Managing Report Logs

To use SAMreport-Lite, you need one or more report log files that are accessible to SAMreport-Lite. Each report log must be written by a single vendor daemon on a single host. (Vendor daemons running on more than one server must each write to their own report logs.) SAMreport-Lite cannot produce reports from debug log files (lmgrd's standard output).

How to Turn on a Report Log

SAMreport-Lite can read report logs that are accessible to the machine where SAMreport-Lite runs—either by being located on the machine where SAMreport-Lite runs or via a network share.

After you enable report logging your vendor daemon will be writing a report log from which you can generate a report with SAMreport-Lite. Depending on your license usage, you should wait a few hours or a few days before generating a report from this report log.

The options files and license files for each license server in a redundant license server configuration must also be set up in order for report logging to continue when the master changes. If a master license server goes down, the new master will read its license and options files and write to its own report log.

To enable report logging for one of your Flexnet vendor daemons

1. Create an options file for the vendor daemon, if one doesn't already exist. The options file is a plain text file with any name (An .opt extension is recommended).

   For example, for a vendor daemon called vend, the options file could be:

   \texttt{C:\Program Files\Autodesk Network License Manager\vend.opt}
2. In the options file, enter a line of the following form:

```
REPORTLOG + path \ ReportLogFileName
```

**NOTE** The line `+ path \ ReportLogFileName` cannot contain any spaces unless the entire line is contained within quotation marks, as in: `"+ path \ ReportLogFileName"`.

The leading “+” character tells the vendor daemon to append output to the report log each time the vendor daemon starts, rather than clearing and overwriting the report log. There is no space after the “+” character.

Each vendor daemon must write its own report log. Do not direct multiple vendor daemons to write to the same report log. SAMreport-Lite (starting with v3.0d) will not process any report log that has been written by more than one vendor daemon on more than one host.

3. Add the path and file name of the options file to the end of the DAEMON line in the license file.

4. Restart the license server.

When you change or create an options file, you must restart the license server in order for those changes to take effect. Rereading the license file is not sufficient.

### Size of the Report Log

A good estimate of the size of your report log (from FLEXnet pre-v5 vendor daemons) is 100 bytes per checkout or checkin, or about 20-25% bigger than the portion of the debug log pertaining to that vendor daemon. FLEXnet v5+ daemons generate report log files that are approximately 25% of the size of pre-v5 report log files.

### Flushing Data to a Report Log

For efficiency, the license server periodically flushes usage events to the report log. The frequency of these flushes depends on the activity level of the license server as well as on the version and configuration of the vendor daemon. To run a report with up-to-the-minute usage information, before running the report, manually flush data from the buffer to the report log by causing the vendor daemon to reread its license file with the FLEXnet utility, lmreread.
Managing Report Logs

Remember that you can produce a report from multiple report logs as long as each report log is written by a single vendor daemon running on a single machine. (Vendor daemons running on more than one redundant server must write to their own report logs.) Therefore, to keep the size of report logs manageable, you should regularly close out a current report log and begin to write to a new one. This process is known as rotating report logs. A recommended method for rotating report logs is provided later in this section.

You may want to automate the process of managing each license server's report logs. The following steps can be performed on a regular basis:

1. Rotate a report log. To avoid corruption in your report logs, it is recommended that you rotate your logs with the FLEXnet utility, lmswitchr (found in the lmtools interface).
2. Update the vendor daemon's options file(s).
3. Move the older report log to a designated location.
4. Archive (and probably compress) a report log when it is no longer needed to run reports.

You must rotate a report log at the following times:

- If you move the license server to a new machine.
  If SAMreport-Lite detects that the license server HostID changes in a report log used to generate a report, it will stop processing the report log and include only the data preceding the HostID change in the report.

- If a vendor daemon name changes.
  If SAMreport-Lite detects that the vendor daemon name changes in the report log used to generate a report, it will stop processing the report log and include only the data preceding the vendor daemon name change in the report.

You may want to rotate a report log at a regular time interval, such as weekly or monthly, depending on how quickly the report log grows. The rotation of a report log does not need to be tied to the interval over which you run your reports—remember that you can run a report on multiple report logs and that you can filter report data with designated start and end dates. You may also want to rotate report logs when the license limit...
for a feature changes, but alternatively, you can also set start and end date filters to isolate usage for given license limits.

**NOTE** You can corrupt a report log by rotating it incorrectly. A report log must begin with a header that is written by the vendor daemon. Without this header, the report log is corrupted. The data in the report log is unusable and unsalvageable from the start of the report log until the first time in that report log that the license server is restarted.

The report log will have no header and will be corrupted if you manually copy an active report log to a new file name, delete the original active report log, and keep the vendor daemon writing to the original active report log file name.

**Finding the Version of the Vendor Daemon and lmswitchr**

How you are able to rotate report logs depends on the version of the vendor daemon and lmswitchr that you use. The -switchlog batch option in SAMsuite uses lmswitchr.

Find the version of the vendor daemon. To find the version of a vendor daemon, start lmtools, the FLEXnet utility. Select the Utilities tab where you can find the version of FLEXnet that is built into a file. Enter or browse to the vendor daemon and click the Find Version button. The FLEXnet version will be displayed at the bottom of the lmtools window.

lmswitchr is found in the lmtools interface. Check the version of lmtools (and therefore lmswitchr) by selecting Help ➤ About.

**Rotating a Report Log with lmswitchr**

This method of rotating a report log is recommended if you are not using SAMsuite.

1. Start lmtools. In the Service/License File tab, select the license server whose report log you want to rotate. Click the Switch Report Log tab. Enter the Vendor Name and the New Report Location. Be sure to specify a new file name (do not reuse the old file name) for the new report log. Click the Switch Report Log button.
2 Edit the options file with the new report log path and file name. If the license server goes down and comes back up, the vendor daemon will read its options file and will continue to write to the new report log. For redundant license servers, update each of the three options files.

3 Move the closed report log to where it can be accessed for reporting and storage. You will move one report log for a single license server and up to three report logs for a redundant license server.

4 Eventually you will not need to run reports on some of your old report logs. Those report logs can be compressed and archived to a location that does not necessarily need to be accessed by SAMreport-Lite.

Avoiding Corruption in Report Logs

FLEXnet has been improved from version to version to make report logging more robust. Nevertheless, particularly in older versions of the vendor daemon, corruption can occur in the report log.

Follow these guidelines to avoid corrupt report log files:

- In pre v 5.1 vendor daemons, rereads, and shutdowns could possibly introduce corruption, particularly if the server is busy. With these older vendor daemons, the best policy is to issue a reread or shutdown when no licenses are checked out, if possible.

- Issuing an lmdown command while the server is shutting down can cause corruption.

- Don't move, copy, or edit the report log file while the server is running.

- Never configure more than one license server to write to the same report log file. In the case of a redundant server, each vendor daemon must write to a distinct file, preferably one that is local to the server machine. Even if the report log is not corrupted, SAMreport-Lite will not run a report using a report log that has been written by a vendor daemon running on more than one license server machine.

- Never configure different vendor daemons to write to the same report log file. Even if the report log is not corrupted, SAMreport-Lite will not run a report using a report log that has been written by more than one vendor daemon.

- Do not use lmswitchr or -switchlog to switch the report log to an existing report log file. Switch to a file with a new name.
Never hand-edit a report log or combine report logs together into the same file.

If you change a server host name, make sure you stop the license manager and create a new report log when the name change is complete.
This section lists SAMreport-Lite runtime error messages and the output report log details.

### Runtime Error Messages

The following runtime error messages may be written to the Status History tab of the SAMreport-Lite interface or to a terminal window:

<table>
<thead>
<tr>
<th>Error</th>
<th>Output Report Log</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error: Report log has been corrupted (-4) file line no (id 50)(minor -1) (Invalid key found, record lost)</td>
<td>Corrupt report log event found in a report log. May be associated with a vendor daemon crash.</td>
</tr>
<tr>
<td>Error: Internal Error (-7) file line no (id 54)(minor 0) feature key</td>
<td>Indicates an unexplained problem in SAMreport-Lite. This error should be reported to Autodesk®.</td>
</tr>
<tr>
<td>Error: A report log is missing (-9) file line no (id 40)(minor 0) feature key</td>
<td>Report log contains a gap of significant duration between an end (or lmswitchr) and the following start event.</td>
</tr>
<tr>
<td>Error: Report log is truncated (-11) file line no (id 48)(minor -5) (Vendor daemon crashed and restart)</td>
<td>Report log event fragment is seen immediately followed by a restart. The feature corresponding to the event fragment is undetermined. Usually caused by vendor daemon crash.</td>
</tr>
<tr>
<td>Error</td>
<td>Output Report Log</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Error: Reportlog is truncated (-11) file line no (id 48)(minor -5) (Vendor daemon crashed and restart) feature key</td>
<td>Report log event fragment is seen immediately followed by a restart. The feature corresponding to the event fragment is shown. This event is unusable. Usually caused by vendor daemon crash.</td>
</tr>
<tr>
<td>Error: Reportlog is truncated (-11) file line no (id 42)(minor 0) feature key</td>
<td>Report log file ends abruptly. Probably caused by reading or copying the report log while the vendor daemon is running. Could also be the result of a vendor daemon crash with no subsequent restart.</td>
</tr>
<tr>
<td>Error: An error was found in the reportlog (-13) file line no (id 51)(minor -4) (Checkout occurred without checkin, recovery attempted) feature key</td>
<td>No matching checkin event found for a checkout event. Because the error is reported much later than the actual error occurred, the line number is not particularly relevant. Sometimes this error is reported in error.</td>
</tr>
<tr>
<td>Error: An error was found in the reportlog (-13) file line no (id 37)(minor -7) (A data field is corrupted, record recovered, field recovery attempted) feature key</td>
<td>Indicates corruption in one of the report event fields.</td>
</tr>
<tr>
<td>Error: End date may be using 2 digit year instead of 4 digits Error occurred: gsi. SAMreport-Lite .JrepException: Unable to generate report.</td>
<td>This is an example of an error that occurs when a parameter or an argument is invalid and a report cannot be generated. The first line describes which parameter or argument is invalid.</td>
</tr>
<tr>
<td>Error: ln file vendor changed from vendor_name1 (hostid1) to vendor_name2 (hostid2). No further events will be read from this file.</td>
<td>This report log has been written by more than one vendor daemon or by a vendor daemon running on more than one HostID.</td>
</tr>
<tr>
<td>Error reporting threshold of 2000 has been reached. No further errors will be reported.</td>
<td>Corruption: Significant corruption in the input report log(s) has rendered parts of this report suspect. Please contact your Autodesk dealer or reseller.</td>
</tr>
</tbody>
</table>
Index

C
corrupted report logs 27

D
daemons
  vendor daemons 8, 26
dates
  report formats 21

E
errors
  SAMreport-Lite messages 29

F
files
  SAMreport-Lite formats 18
  filtering
    SAMreport-Lite data 20
  FLEXnet tools 8
  flushing data 24
  formatting dates 21

I
input reports 17
installation
  Java Runtime Environment 3
  SAMreport-Lite 2

J
Java Runtime Environment (JRE) 3
JRE (Java Runtime Environment) 3

L
licences
  about 8
license files
  SAMreport-Lite 1
license servers
  Options files 3
  SAMreport-Lite report logs 17
  lmswitchr 26

O
Options files (SAMreport-Lite) 3
output reports 17

R
report log files
  corruption in 27
  flushing data 24
  log files 17
  managing 23
  multiple logs 25
  rotating 26
  size 24
reports
  date formats 21
  error messages 10
  generating 9
  input and output reports 17
  report logs 17, 23
  start and end dates 21
  timestamps 21
  usage summary reports 13
RIF files 19
rotating
  report logs 25
SAMreport-Lite
about  1, 7
date formats  21
displaying output  18
error messages  10, 29
filtering output  20
flushing data  24
generating reports  9
input and output reports  17
installing  2
Java Runtime Environment  3
license files  1
license management  8
Options files  3
output formats  18
report logs  23
timestamps  21

usage summary reports  13
vendor daemons and lmswitchr  26

time stamps
SAMreport-Lite settings  21
troubleshooting
report logs  27
SAMreport-Lite error messages  29

usage summary reports  13

vendor daemons  8, 26